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Regulatory Compliance

This product has been designed and
tested in accordance with accepted
industry standards, and has been supplied
in a safe condition. To review the
Declaration of Conformity, go to
http://www.keysight.com/go/conformity

Warranty

THE MATERIAL CONTAINED IN THIS
DOCUMENT IS PROVIDED "AS IS," AND
IS SUBJECT TO BEING CHANGED,
WITHOUT NOTICE, IN FUTURE EDITIONS.
FURTHER, TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW,
KEYSIGHT DISCLAIMS ALL WARRANTIES,
EITHER EXPRESS OR IMPLIED, WITH
REGARD TO THIS MANUAL AND ANY
INFORMATION CONTAINED HEREIN,
INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF MERCHANT
ABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. KEYSIGHT
SHALL NOT BE LIABLE FOR ERRORS OR
FOR INCIDENTAL OR CONSEQUENTIAL
DAMAGES IN CONNECTION WITH THE

FURNISHING, USE, OR PERFORMANCE OF
THIS DOCUMENT OR OF ANY
INFORMATION CONTAINED HEREIN.

SHOULD KEYSIGHT AND THE USER HAVE A

SEPARATE WRITTEN AGREEMENT WITH
WARRANTY TERMS COVERING THE
MATERIAL IN THIS DOCUMENT THAT
CONFLICT WITH THESE TERMS, THE
WARRANTY TERMS IN THE SEPARATE
AGREEMENT SHALL CONTROL.

KEYSIGHT TECHNOLOGIES DOES NOT
WARRANT THIRD-PARTY SYSTEMLEVEL
(COMBINATION OF CHASSIS,
CONTROLLERS, MODULES, ETC.)
PERFORMANCE, SAFETY, OR REGULATORY
COMPLIANCE, UNLESS SPECIFICALLY
STATED.

Technology Licenses

The hardware and/or software described in
this document are furnished under a license
and may be used or copied only in
accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer
software,” as defined by Federal Acquisition
Regulation (“FAR”) 2.101. Pursuant to FAR
12.212 and 27.405-3 and Department of
Defense FAR Supplement (“DFARS”)
227.7202, the U.S. government acquires
commercial computer software under the
same terms by which the software is
customarily provided to the public.
Accordingly, Keysight provides the Software
to U.S. government customers under its
standard commercial license, which is

embodied in its End User License Agreement

(EULA), a copy of which can be found at
http://www.keysight.com/find/sweula. The
license set forth in the EULA represents the
exclusive authority by which the U.S.
government may use, modify, distribute, or
disclose the Software. The EULA and the
license set forth therein, does not require or
permit, among other things, that Keysight:
(1) Furnish technical information related to
commercial computer software or
commercial computer software
documentation that is not customarily
provided to the public; or (2) Relinquish

to, or otherwise provide, the government
rights in excess of these rights customarily
provided to the public to use, modify,
reproduce, release, perform, display, or
disclose commercial computer software or
commercial computer software
documentation. No additional government
requirements beyond those set forth in
the EULA shall apply, except to the extent
that those terms, rights, or licenses are
explicitly required from all providers of
commercial computer software pursuant
to the FAR and the DFARS and are set
forth specifically in writing elsewhere in
the EULA. Keysight shall be under no
obligation to update, revise or otherwise
modify the Software. With respect to any
technical data as defined by FAR 2.101,
pursuant to FAR 12.211 and 27.404.2 and
DFARS 227.7102, the U.S. government
acquires no greater than Limited Rights as
defined in FAR 27.401 or DFAR 227.7103-
5 (c), as applicable in any technical data.

Safety Notices

A CAUTION notice denotes a hazard. It
calls attention to an operating procedure,
practice, or the like that, if not correctly
performed or adhered to, could result in
damage to the product or loss of
important data. Do not proceed beyond a
CAUTION notice until the indicated
conditions are fully understood and met.

A WARNING notice denotes a hazard. It
calls attention to an operating procedure,
practice, or the like that, if not correctly
performed or adhered to, could result in
personal injury or death. Do not proceed
beyond a WARNING notice until the
indicated conditions are fully understood
and met.

The following safety precautions should
be observed before using this product and
any associated instrumentation. This
product is intended for use by qualified
personnel who recognize


http://www.keysight.com/go/conformity

shock hazards and are familiar with the
safety precautions required to avoid
possible injury. Read and follow all
installation, operation, and maintenance
information carefully before using the
product.

If this product is not used as specified, the
protection provided by the equipment
could be impaired. This product must be
used in a normal condition (in which all
means for protection are intact) only.

The types of product users are:

— Responsible body is the individual or
group responsible for the use and
maintenance of equipment, for ensuring
that the equipment is operated within its
specifications and operating limits, and
for ensuring operators are adequately
trained.

— Operators use the product for its
intended function. They must be trained
in electrical safety procedures and
proper use of the instrument.They must
be protected from electric shock and
contact with hazardous live circuits.

— Maintenance personnel perform routine
procedures on the product to keep it
operating properly (for example, setting
the line voltage or replacing
consumable materials). Maintenance
procedures are described in the user
documentation.The procedures
explicitly state if the operator may
perform them. Otherwise,they should

be performed only by service personnel.

— Service personnel are trained to work
on live circuits, perform safe
installations, and repair products.Only
properly trained service personnel may
perform installation and service
procedures.

Operator is responsible to maintain safe
operating conditions. To ensure safe
operating conditions, modules should not
be operated beyond the full temperature
range specified in the Environmental and
physical specification. Exceeding safe
operating conditions can result in shorter
lifespans, improper module

performance and user safety issues. When
the modules are in use and operation within
the specified full temperature range is not
maintained, module surface temperatures
may exceed safe handling conditions which
can cause discomfort or burns if touched. In
the event of a module exceeding the full
temperature range, always allow the module
to cool before touching or removing modules
from chassis.

Keysight products are designed for use with
electrical signals that are rated
Measurement Category | and Measurement
Category Il, as described in the International
Electro-technical Commission (IEC)
Standard IEC 60664. Most measurement,
control, and data I/0 signals are
Measurement Category | and must not be
directly connected to mains voltage or to
voltage sources with high transient over-
voltages. Measurement Category |l
connections require protection for high
transient over-voltages often associated with
local AC mains connections.Assume all
measurement, control, and data 1/0
connections are for connection to Category |
sources unless otherwise marked or
described in the user documentation.

Exercise extreme caution when a shock
hazard is present. Lethal voltage may be
present on cable connector jacks or test
fixtures. The American National Standards
Institute (ANSI) states that a shock hazard
exists when voltage levels greater than 30V
RMS, 42.4V peak, or 60VDC are present. A
good safety practice is to expect that
hazardous voltage is present in any unknown
circuit before measuring.

Operators of this product must be protected
from electric shock at all times. The
responsible body must ensure that operators
are prevented access and/or insulated from
every connection point. In some cases,
connections must be exposed to potential
human contact. Product operators in these
circumstances must be trained to protect
themselves from the risk of electric shock. If
the circuit is capable of operating at or
above 1000V,

no conductive part of the circuit may be
exposed.

Do not connect switching cards directly to
unlimited power circuits. They are
intended to be used with impedance-
limited sources. NEVER connect switching
cards directly to AC mains. When
connecting sources to switching cards,
install protective devices to limit fault
current and voltage to the card.

Before operating an instrument, ensure
that the line cord is connected to a
properly grounded power receptacle.
Inspect the connecting cables, test leads,
and jumpers for possible wear, cracks, or
breaks before each use.

When installing equipment where access
to the main power cord is restricted, such
as rack mounting, a separate main input
power disconnect device must be
provided in close proximity to the
equipment and within easy reach of the
operator.

For maximum safety, do not touch the
product, test cables, or any other
instruments while power is applied to the
circuit under test. ALWAYS remove power
from the entire test system and discharge
any capacitors before: connecting or
disconnecting cables or jumpers,
installing or removing switching cards, or
making internal changes, such as
installing or removing jumpers.

Do not touch any object that could
provide a current path to the common
side of the circuit under test or power line
(earth) ground. Always make
measurements with dry hands while
standing on a dry, insulated surface
capable of withstanding the voltage being
measured.

The instrument and accessories must be
used in accordance with its specifications
and operating instructions, or the safety of
the equipment may be impaired.

Do not exceed the maximum signal levels
of the instruments and accessories, as
defined in the specifications and operating
information,and as shown on the
instrument or test fixture panels, or
switching card.



When fuses are used in a product, replace
with the same type and rating for
continued protection against fire hazard.

Chassis connections must only be used as
shield connections for measuring circuits,
NOT as safety earth ground connections.

If you are using a test fixture, keep the lid
closed while power is applied to the
device under test. Safe operation requires
the use of a lid interlock.

Instrumentation and accessories shall not
be connected to humans.

Before performing any maintenance,
disconnect the line cord and all test
cables.

To maintain protection from electric shock
and fire, replacement components in
mains circuits - including the power
transformer, test leads, and input jacks -
must be purchased from Keysight.
Standard fuses with applicable national
safety approvals may be used if the rating
and type are the same. Other components
that are not safety related may be
purchased from other suppliers as long as
they are equivalent to the original
component (note that selected parts
should be purchased only through
Keysight to maintain accuracy and
functionality of the product). If you are
unsure about the applicability of a
replacement component, call an Keysight
office for information.

No operator serviceable parts inside.Refer
servicing to qualified personnel. To
prevent electrical shock do not remove
covers. For continued protection against
fire hazard, replace fuse with same type
and rating.
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The CE mark is a registered trademark of
the European Community.

&

Australian Communication and Media
Authority mark to indicate regulatory
compliance as a registered supplier.

ICES/NMB-001
ISM GRP.1 CLASS A

This symbol indicates product compliance
with the Canadian Interference-Causing
Equipment Standard (ICES-001). It also
identifies the product is an Industrial
Scientific and Medical Group 1 Class A
product (CISPR 11, Clause 4).

KCC-REM-KST-
BLMboooox

South Korean Class A EMC Declaration. This
equipment is Class A suitable for
professional use and is for use in

electromagnetic environments outside of the

home.
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This product complies with the WEEE
Directive marketing requirement. The affixed
product label (above) indicates that you
must not discard this electrical/electronic
product in domestic household waste.
Product Category: With reference to the
equipment types in the WEEE directive
Annex 1, this product is classified as
“Monitoring and Control instrumentation”
product. Do not dispose in domestic
household waste. To return unwanted
products, contact your local Keysight office,
or for more information see http://about.
keysight.com/en/companyinfo/environment
/takeback.shtml

y
Atad
This symbol indicates the instrument is
sensitive to electrostatic discharge (ESD).
ESD can damage the highly sensitive
components in your instrument. ESD
damage is most likely to occur as the
module is being installed or when cables
are connected or disconnected. Protect
the circuits from ESD damage by wearing
a grounding strap that provides a high
resistance path to ground. Alternatively,
ground yourself to discharge any builtup
static charge by touching the outer shell
of any grounded instrument chassis
before touching the port connectors.

A

This symbol on an instrument means
caution, risk of danger. You should refer
to the operating instructions located in
the user documentation in all cases where
the symbol is marked on the instrument.

&
This symbol indicates the time period
during which no hazardous or toxic
substance elements are expected to leak
or deteriorate during normal use. Forty

years is the expected useful life of the
product.
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Introduction

This section provides an overview of the X-Series Measurement Applications for
Modular Instruments (M90XA Software) and links to the related documentation for
MOAOXA.

= Qverview of MOOXA Software

- Related Documentation

Overview of MOOXA Software

X-Series Measurement Applications for Modular Instruments (M90XA Software)
expand the capabilities of your M9391A or M9393A PXle Vector Signal Analyzers
(PXI'VSAs). These applications are the same applications used to increase the
capability and functionality of Keysight's X-Series signal analyzers, and include the
same GUI and SCPI programming commands. By combining the raw hardware
speed of the PXI VSAs and the X-Series measurement applications, you can test
more products in less time while ensuring measurement continuity from design to
manufacturing. The M9OXA Software transforms PXI VSAs into standards-based RF
transmitter testers, providing fast RF conformance measurements to help you test
your components and devices in high-volume manufacturing.

M9O0XA software supports M9393A VSA Extended Frequency Mode (Cabling with
the M9169E, 3.6GHz to 50GHz, option M3393A-FRX is required, and option
M9393A-F27 is a prerequisite for option-FRX).

From M90XA 4.0 release onwards, only M9063A AnalogDemod, M9068A Phase
Noise, and M9064A VXA Signal Analysis Measurement Applications can work
with the M9393A VSA Extended Frequency Mode Hardware configuration (3.5
GHz-50GHz). Other applications supported in M90OXA can still be accessed, but
they may not work correctly with M9393A VSA Extended Frequency Mode.

From M90XA 6.0 release onwards, Traditional Ul and Touch Ul are provided to
the customer. Use of Touch Ul is recommended for the applications, which
support both Traditional and Touch Ul because most of the new features will be
implemented for Touch Ul only.

X-Series Measurement Applications for Modular Instruments

Following X-Series Measurement Applications are supported for Modular
Instruments:

Traditional Ul
- N9O63EMOD - Analog Demodulation Measurement Application
- N9064EMOD - Vector Signal Analysis Measurement Application, VXA
- N9068EMOD - Phase Noise Measurement Application
- N9069EMOD - Noise Figure Measurement Application
= N9071EMOD - GSM/EDGE Measurement Application

Keysight MOOXA X-Series Measurement Applications for Modular Instruments



= N9072EMOD - CDMA2000 Measurement Application

= N9073EMOD - W-CDMA Measurement Application

- N9076EMOD - CDMA TxEV-DO Measurement Application

- N9077EMOD - WLAN 802.11 Measurement Application

-~ N9O77EM1D - WLAN 802.1Tac/ax Measurement Application
- N9079EMOD - TD-SCDMA Measurement Application

- N908OEMOD - LTE-Advanced FDD Measurement Application
- N908T1EMOD - Bluetooth® Measurement Application

- N9082EMOD - LTE TDD Measurement Application

Touch Ul
- N9054EMOE - Flexible Digital Demodulation Application, VMA
- N9O54EM1E - Custom OFDM Measurement Application, VMA
- N9063EMOE - Analog Demodulation Measurement Application
- N9068EMOE - Phase Noise Measurement Application
= N9069EMOE - Noise Figure Measurement Application
= N9071EMOE - GSM/EDGE Measurement Application
- N9072EMOE - CDMA2000 Measurement Application (Remote Control Only)
- N9073EMOE - W-CDMA Measurement Application

- N9076EMOE - CDMA 1xEV-DO Measurement Application (Remote Control
Only)

- N9077EMOE - WLAN 802.11 Measurement Application

- N9077EMTE - WLAN 802.11ac/ax Measurement Application

- N9079EMOE - TD-SCDMA Measurement Application (Remote Control Only)
- N908OEMOE - LTE-Advanced FDD Measurement Application

- N908OEMSE - NB-loT and eMTC Measurements Application

- N90OBOEMA4E - LTE V2X Measurements Application

= N9O8TEMOE - Bluetooth® Measurement Application

- N9082EMOE - LTE TDD Measurement Application

= N9085EMOE - 5G NR Measurement Application

Keysight MOOXA X-Series Measurement Applications for Modular Instruments 10



11

~ N9OxxEMXE licenses can enable both Traditional and Touch Ul
applications (such as WLAN, Bluetooth, Analog Demod, GSM,
LTE, Noise Figure, Phase Noise, WCDMA), except the
applications that don’t support Traditional Ul. For example,
N9054EMOE - Vector Modulation Analysis, VMA Application. This
application only supports Touch UL.
N90xxEMxD licenses can only enable Traditional Ul applications.
Some applications like VXA, CDMA2000, CDMA 1xEVDO, and TD-
SCDMA support Traditional Ul only.

For details on the supported licenses and the product information, refer to M90OXA
Software Licenses.

For a high-level overview of the MI0OXA Software use model, refer to High-level
Architecture.

Keysight MOOXA X-Series Measurement Applications for Modular Instruments



Related Documentation

In addition to this Startup Guide, you can access the following documents relevant
to the MOOXA Software.

Document Format Path to Access

User's and Programmer's Guides CHM  Start > All Programs >
Keysight > MOOXA X-Series
Applications 24.0 > Help
Alternatively, Launch MIOXA
~ MI063A Analog Demod Software, switch the mode to

~ MSOB4A VXA Signal Analyzer select specific application and
~ M9068A Phase Noise press F1
= M9069A Noise Figure

- M9071A GSM/EDGE

= M9072A cdma2000

= M9073A WCDMA

- M9076A 1xEV-DO

- M9077A WLAN

= M9079A TD-SCDMA

= M9080A LTE

- M9080B LTE-A FDD

- M9081A Bluetooth

= M9082A LTE-TDD

- M9082B LTE-ATDD

~ M9080 NB-loT and eMTC

Include SCPI commands and queries for the basic measurement
functionality.

Keysight MOOXA X-Series Measurement Applications for Modular Instruments 12



Document

Format Path to Access

Measurement Guides CHM

Include examples of measurements made using the measurement
application and conceptual information.

= M9063A Analog Demod
~ MI064A VXA Signal Analyzer
~ M9Y068A Phase Noise

- M9069A Noise Figure

- M9071A GSM/EDGE

= M9072A cdma2000

= M9073A WCDMA

- M9076A 1xEV-DO

= M9077A WLAN

= M9079A TD-SCDMA

= M9080A LTE

- M9080B LTE-A FDD

- M9081A Bluetooth

- M9082A LTE-TDD

- M9082B LTE-ATDD

= M9080 NB-loT and eMTC

M3000 API Documentation CHM

Provides detailed documentation of Interfaces & Resources.
Programmer’s reference for the M9000 .NET APl which provides
the ability to share resources between different callers in the same
process.

M39000 C API Documentation CHM

Help system for M9000 unmanaged C API.
M9O0XA IVI Driver (Documentation) CHM

Provides detailed documentation of the IVI-COM and IVI-C driver
API functions, as well as information to help you get started with
using the IVI drivers in your application development environment.

Start > All Programs > Keysight
> MOOXA X-Series
Applications 24.0 > Help >
Measurement Guides

Start > All Programs >
Keysight > Keysight M3000
Measurement Framework

Start > All Programs > Keysight
> Keysight M9000
Measurement Framework

Start > All Programs >
Keysight Instrument Drivers >
[VI-COM-C Drivers >
AgMI0XA X-Series
Applications

Keysight MOOXA X-Series Measurement Applications for Modular Instruments



Document Format Path to Access

Hardware Documentation PDF - Start > All Programs
Provides hardware-specific documentation for the PXI modules. /CHM > Keysight > M9391
Includes hardware specifications and instructions on how to install, - Start > All Programs
update, verify, and troubleshoot the measurement hardware. > Keysight > M9393
Revision History PDF Start > All Programs >

Provides a list of enhancements and issues resolved in the various
releases.

Keysight > MOOXA X-Series
Applications 24.0 > Help

- For a portable version of the User documentation (PDF and CHM), visit
product website and download files from the Document Library.

Keysight MOOXA X-Series Measurement Applications for Modular Instruments
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Installation and License Setup

This section describes software prerequisites; and how to install and setup licenses
for MOOXA Software.

- System Requirements
- Installing M9OXA Software
- Setting up Licenses

System Requirements

This page contains macros or features from a plugin which requires a valid license.

You will need to:
1. Visit the Universal Plugin Manager and acquire the necessary licenses.

Licensing Help?
This page contains macros or features from a plugin which requires a valid license.

You will need to:
1. Visit the Universal Plugin Manager and acquire the necessary licenses.

Licensing Help?

System Requirements

Following is the Keysight's recommended configuration for M9OXA Software:

CPU 2 GHz or faster 64-bit (x64) processor
RAM 8 GB recommended
Hard Disk 2 GB available

Additional DVD to load software; license transfer requires network access, USB Flash drive, USB hard
Drives drive, or USB DVD drive

Operating Microsoft Windows® 7 Professional, Enterprise, or Ultimate (64-bit)

System Microsoft Windows® 10 Professional, Enterprise (64-bit)
Internet 11.0 or above
Explorer

M90XA Software is no longer supported on 32-bit machines, and from M90XA
6.0 release onwards, the 32-bit version of the software is also not supported.

Keysight MOOXA X-Series Measurement Applications for Modular Instruments
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Setup Notes

For appropriate viewing of the X-Apps for Modular Instruments, screen resolution
must be set to 96dpi or lower.

Set the custom text size (DPI) to 100%.

Go to Control Panel > Display > Set custom text size (DPI). Select 100% in the
Scale to this percentage of normal size drop-down list.

Control Panel Home . . . Custom DPI Setting |
Make it easier to read what's on your screen

A You can change the size of text and other items on your screen by choosing ene of these options. To For a custom DPI setting, select = percentage from the list, or
i temporarily enlarge just part of the screen, use the [agnifier tool. drag the ruler with your mou:
[ Calibrate color

Scale to this percentage of normal size: -]
Change display settings T
A @ Smaller - 100% (default) Preview e
Connect to a projector - o
150%
Adjust ClearType text o 1 200% H]

- - Medium - 125%
Set custom text size (DP! s ° 9 point Segoe Ul at 96 pixels per inch.

© Larger - 150%

P T——

Installing MOOXA Software

This section describes the prerequisites and procedure to install the MI0OXA
Software on your computer.

The M9I0XA Software must be installed on the same computer that shares the
PXI backplane with the M9391A or M9393A VSAs.

Prerequisites

- Agilent/Keysight 10 Libraries and M9391A or M9393A driver must be
installed before installing MI0OXA Software.

- Agilent/Keysight 10 Libraries Suite: 2018 Update 1 (18.1.23218.2) or
higher version

- Recommended VSA hardware drivers:
- M9391A driver: 2.1.230.71 or higher version

- M9393A driver for M9393A VSA Classic Mode (9KHz to
27GHz): 2.0.225.1 or higher version

- M9393A driver for M9393A VSA Extended Frequency Mode
(3.6GHz to 50GHz): 2.1.875.1 or higher version

M90XA Software Installer
Download the installer package from http://www.keysight.com/find/M30XA-SW.
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Installation Procedure

Launch the installer file to run the setup.

»

Keysight MI0XA ¥-Series Applications - InstallShield Wizard Il
Welcome to the InstallShield
Wizard for Kepsight M90<A
X-Series Applications. EF:LSJ,IEI:!I

The InstallShield "Wizard will install Eeysight b 90000
#-Senes Applications verzion 24.0.29.0 on your
computer. To continue, click Mest.

KEYSIGHT

TECHNOLOGIES

< Back Mext > ][ Cancel

NOTE The version number of Keysight MOOXA X-Series Applications in the above
screen will match the version being installed.

After you accept the terms of the license agreement, the Installation wizard
prompts you to choose either a Complete or Custom setup to install.

Keysight MOOXA X-Series Measurement Applications for Modular Instruments



Keysight M0XA X-Series Applications - InstallShield Wizard ﬁ

Setup Type
KEYSIGHT

Select the zetup type toinstall. TECHNOLOGIES

Pleaze zelect a setup ype.

Al program features will be installed. [Reguires the most digk space. ]

(71 Cugtom

Select which program features you want inztalled. Recommended for
advanced uzers.

[ < Back ][ Mext » ][ Cancel ]

The Custom setup enables you to choose the features to install, out of the
following:

- Keysight M9000 Measurement Framework
- Keysight MO0OXA X-Series Applications
= MSOXA VI Driver

This enables you to install only M9000 Core software and the MSOXA VI Driver in
case you do not want to run M9OXA X-Series Measurement Applications.
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Keysight MIOXKA X-Series Applications - InstallShield Wizard =

Select Features

KEYSIGHT

Select the features setup will inztall, rECH NOLOGIES

Select the features pou want to install, and deselect the features wou want b uninstall.

Dezcription

s [enzight M3000 Measurement Frarmework
B Keyzight M90d 2-Senes Applications
----- 98, (W1 Driver

0.00 MB of space required on the C dive
33512585 MB of zpace available on the C diive

< Back ][ Mest » ][ Cancel

Follow the guided tour to complete the installation.
After the installation completes, the following applications get installed on your
PC,:
- Keysight MOOXA X-Series Measurement Applications (This includes M9000
Core Software)
= M9OXA IVI Driver (AgM90XA)

- Keysight License Manager

Setting up Licenses

This section describes Keysight software licensing and the licenses required to run
MOO0XA Software.

MO0XA Software Licensing

Licenses for M90OXA Software are Transportable Perpetual licenses. Perpetual
licenses do not expire. Transportable licenses can be transferred from one
controller or computer to another, for example from an embedded PXI controller to
an external PC. A single MOOXA Software license will allow running up to four
instances of the software with up to four VSA hardware sets (measurement
channels) in one PXI chassis.

When you purchase MIOXA Software, you are provided with a License Redemption
Entitlement Certificate that documents the licenses to which you are entitled. You
can redeem the certificate at www.keysight.com/find/softwaremanager using the
purchase order number, entitlement certificate number, the host ID of the target
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computer/controller and other details as required by the redemption process.
Additional instructions on how to find your host id are available at ftp://ftp.keysight.
com/pub/dsp/products/HostID.pdf.

The Keysight Software Licensing system issues a license file for each purchased
license, by an e-mail to the address you specify. Each license file is a plain text file
attachment with a file name in the form XXXXXX_YYYYYY.lic. When you receive the
e-mail, save the attached .lic file(s) to the Agilent license directory, which is located
at: C:\Program Files\Agilent\licensing.

Once installed, software licenses for Keysight products can be viewed and
managed from the Keysight License Manager. You can launch the Keysight License
Manager either from Start > All Programs > Keysight License Manager or from the

system tray. @

The licenses for M90OXA Software must be installed by a user with System
Admin privileges.

M9YO0OXA Software Licenses

The following table describes the license options for the various features of MIOXA
Software.

Suspender Licenses

The following table describes the suspender licenses introduced in the current
MO0XA release.

Product/Feature Description

N9O54EMOE-1FP Flexible Digital Demodulation Application, VMA
NIO54EMTE-1FP Custom OFDM Application, VMA
N9O63EMOD/E-TFP  Analog Demodulation Measurement Application
N9064EMOD-1FP Vector Signal Analysis Application, VXA
N9O6BEMOD/E-1FP  Phase Noise Measurement Application
NIO69EMOD/E-TFP  Noise Figure Measurement Application
N9O7TEMOD/E-TFP  GSM/EDGE Measurement Application
N9072EMOD/E-TFP  CDMA2000 Measurement Application

N9073EMOD/E-TFP  W-CDMA Measurement Application
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Product/Feature Description

N9O76EMOD/E-TFP  1xEV-DO Measurement Application

N9077EMOD/E-TFP  WLAN 802.17a Measurement Application

N9O77EM1D/E-1FP  WLAN 802.11ac/ax Measurement Application

N9079EMOD/E-TFP  TD-SCDMA Measurements with HSDPA/8PSK

N9OSOEMOD/E-TFP  LTE-Advanced FDD Measurement Application

N9OS8OEM3E-1FP NB-10T/eMTC Measurement Application

N9OBOEM4E-1FP LTE V2X Measurements Application

N9O8TEMOD/E-TFP  Bluetooth Measurement Application

N9O082EMOD/E-TFP  LTE-TDD Measurement Application

N9O85EMOE-1FP 5G NR Measurement Application

If a license is not available or not valid, the corresponding features/options will
not be enabled in the MI0XA Software.
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Launching MY0XA

This section describes the procedure to launch the MI0OXA Software. It also
describes the various startup options that can be used with the M90XA software.

You can launch M90XA Software from the Start Menu as follows:

- Start > All Programs > Keysight > M90XA X-Series Applications 24.0 >
Keysight MOOXA 24.0 (64-bit)

The splash screen is displayed:

M30XA VSA

| k‘J ATy Vector Signal Analyzer
Jr a]hﬁﬂ “ i | X-Apps 2019 Update 3.0
| J l’ H"‘L#r'

Verzion: M.24.50
www_keysight.comfind MIO0XA

StartMS0xA, Version 24.0.29.0 KEYS IGHT

M2000 Ses=ion OK TECHNOLOGIES
Gefting IV se=sion name from user...

B Keysight Technologies 3H012-2020

After a couple of seconds, the Select IVI Driver Session dialog appears.
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StarthA90XA, - Select IWT Driver Session

Supparted Drivers Found

|,|':'|,QMEGEI'| ﬂ Open SFP...

43333 of VS
Configured driver sessions for Agh9331
|-‘5"-EIM9391-"-"- j [ Simulate [ TouchUl

Model=k 321 4443300 2093504, 93002

| Ok, | Cancel |

A

1. Select one of the two supported drivers (AgM9391 and AgM9393).

2. If you have previously configured an M3391 or M9393 driver session and
saved it to the IVI Configuration Store, then you can see it in the list of
Configured driver sessions for AgM9391 or Configured driver sessions for
AgM3393. You can skip this step and move to Step 3 directly. However, if
you have not already configured an M9391 or M9393 driver session, you can
configure and save it now by using the following steps (Step a through Step
f).

a. Click Open SFP... to launch the Soft Front Panel.

b. Configure an instrument (For details, refer to the M9391 or M9393
documentation, available at Start > All Programs > Keysight > M9391 >
M9391 Help or Start > All Programs > Keysight > M9393 > M9393 Help

c. Click Connect (or Simulate) to start driver session and the Soft Front
Panel.

d. Select File > Save Connection... to save the configuration to the IVI
Configuration Store by name. For example, MyVSA.

e. Close the Soft Front Panel.

f. In the Select IVI Driver Session dialog, select either Configured driver
sessions for AgM9391 or Configured driver sessions for AgM9393 from
the drop-down list to refresh its contents.

You should now see the configuration name, for example, MyVSA.

3. Inthe Select IVI Driver Session dialog, select the desired configured driver
session.
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StarthA90KA, - Select IVT Driver Session

Supported Drvers Found

|.-'-\gMEIEE|3 j Open SFP..
ﬂEM%Eﬂ d Signal Analyzer

Confiqured driver sessions for Aghd9333

|M9393‘*‘- j W Simulate v TouchUl W fm2in
zlot 2-3-4-10

Model=h327 44,44 33084 M 33654+ 93004

0K, | Cancel |

A

4. Select Aux2In check box to set the M9393A frequency range to 3.6GHz -
50GHz.

Aux2In option is visible only when the current AgM9393 VI driver
session does not consist of M9169E Attenuator module.

5. Select the Simulate checkbox if you want to use the M9397 or M9393 in
simulation mode.

6. Select the TouchUI checkbox to launch MOOXA with touch UI.

7. Click OK.
This launches the MSOXA Multi-Touch Ul Software using the selected M9391
or M9393 configuration.
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Keysight MIOXA MI393A D x

WLAN 1 NP
+ G e o
KEYSIGHT |input: RF Input Z: 50 Q Range: 0 dBm Trig: Free Run Center Freq: 3.612500000 GHz

i) Coupling: AC Cormections: Off Gate: O Radio Info: 802.11a/g/ip 20M [Center Frequency AN
Freq Ref: Int(s) 3.612500000 GHz

Span
1 Spectrum S

25.0000000 MHz
Scalel/Div 10.0 dB Ref Value 0.00 dBm

CF Step
5.000000 MHz

Auto
Man

[Center 3.613 GHz #Video BW 1.0000 MHz
[#Res BW 100.00 kHz

[} Sep 04, 2017
=. kj (j - ? 13"25253AM

Keysight M90XA  M9393A O X

JWLAN 1 GSM/EDGE 1 >
[Monitor Spectrum R4 Frequency v |5, <

KEYSIGHT |Input: RF Input Range: 0 dBm Trig: Free Run 'ARFCN: = 124 (3 600000005 GHz)
‘Coupling: AC Freq Ref: Int (S) Radio: Normal BTS, P-GSM

Settings.
Burst: TCH & CCH

8. Click the drop down arrow (highlighted in the above image) to open Mode /
Measurement /View Selector window.

Keysight MOXA M3393A

Mode / Measurement/ View Selector Screen Name

Analog Demod Channel Power

Bluetooth Spurious Emissions
hen Sequencing is On and J
thers are multiple Screens, all

When Sequencing is OFF, only

the selected Screen updates.
GSM/EDGE /EDGE Eva 1Q Waveform
Noise Figure Power Stat CCDF
Phase Noise Occupied BW

LTETDD & LTE-ATDD SEM

‘Vector Modulation Analyzer Power vs Time

W-CDMA with HSPA+ Modulation Analysis

Cancel

9. Select the required mode and measurement, and click OK.

10. Click the highlighted drop-down arrow (highlighted in the below image) to
change other settings.
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Keysight MI0OXA MI393A

WLAN 1 GSM/EDGE 1 B+
Monitor Spectrum Monitor Spectrum
KEYSIGHT et RF Input Z: 50 Range. 0 4Bm Trig: Free Run ARFCN. > 124 (3600000005 GHz)
Coupling: AC Freq Ref. Int(S) Radic: Normal BTS, P-GSM
Burst: TCH & CCH

Lol

5

1 Spectrum

Scale/Div 10.0 dB Ref Value 0.00 dBm Display

[ ]

Input/Qutput

> 12
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3.60(
Span
1.00
BELT
P-GY
BMT |

Trigger

User Menu

[Center 3.6 GHz. Video BW 9.1000 kHz
Res BW 9.1000 kHz

- Sep 04, 2017 wa| (] (00 [%
LS iy dRidts i) wea [L% miniAPAN

Traditional Ul supports 89600 VSA running in-process with MO0XA 24.0. To
start the M90XA and 89600 applications from the Start menu, select All
Programs > Keysight > MO0XA X-Series Applications 24.0 > Keysight M90OXA
24.0 + 89600 VSA (64-bit).

While the multi-touch Ul does not support 89600 VSA running in-process with
M90XA.
Startup Options

There are several startup options that can be used when launching the MOXA
Software. The startup options can be added to the shortcut properties at the end of
the Target line. To open the shortcut properties window, right-click on the shortcut
and select Properties.
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T8 Keysight MO0XA 24,0 (64-bit) Properties ==

Compatiblity | S ecurty | Detailz | Fresious Wersions
General | Shortcut | Optians | Fort | Lot | Calars

Keysight MI0A 24.0 [54-bit

Target type: Application

Target location: 24.0

T arget: sz Agilentu b 90AN 24 DS Larthd 06, ewe ATITTEE

Start in:

Shortcut key:  Mone

Rur: [ Minimized - ]

Comment;

Open File Location ][ Change [can... H Advanced. .. ]

[ 0k, J[ Cancel H Apply
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Startup  Parameter Description

Option

/touch launch M90XA with
touch Ul

/sim Start in simulate mode

/ivi:? Interactive selection of
logical name of
receiver hardware

/ivi: Logical name of receiver hardware Use specific hardware

/modes:  Comma-separated list of mode names (e.g. /modes:WLAN,EDGEGSM) Load specific
Valid modes are ADEMQD, BT, COMATXEV, CDMAZ2K, EDGEGSM, LTE, measurement
LTETDD, LTEAFDD, LTEATDD, PNOISE, TDSCDMA, VSA, WCDMA, applications
WLAN, NFIG, VMA, NR5G, BASIC

/hislip: ~ Device number Use a specific HiSLIP
device number

/telnet:  Port Use a specific telnet
port number

/socket:  Port Use a specific socket
port number

/align Run alignment on
startup

/silent Non-interactive mode

/debug Leave the StartM30XA.
exe console window
open

/uor/? Show the command

line usage instructions

/aux2in Set the M9393A
frequency range to 3.6
GHz - 50GHz

/noclose Disable the close

button on MOOXA GUI
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If you are combining multiple startup options they should be separated by
spaces. There should be no spaces within a startup option.
For example, /i vi : MyVsa [/ modes: WLAN, EDGEGSM / hi sl i p: 1
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Using MOOXA Software

When you combine the raw hardware speeds of the PXI VSAs and the X-Series
Measurement Applications for Modular Instruments, you can test more products in
less time while ensuring measurement continuity from design to manufacturing.

The X-Series Measurement Applications for Modular Instruments are the same as
those available for Keysight's X-Series signal analyzers. Consistent and intuitive
user interfaces reduce the need for re-training or familiarization and also simplify
measurement setup. Programming consistency includes SCPI compatibility across
platforms to enable software re-use from benchtop to modular and speed up test
system development. This consistency reduces risk in the transition from the
development phase to the manufacturing.

In addition, Keysight's X-Series Measurement Applications for Modular Instruments
include a unique resource manager that provides direct access to PXI VSA
hardware drivers for the fastest power and spectrum-based measurements while
simultaneously using fast modulation quality measurements provided in the X-
Series Measurement Applications. Because of the resource manager, switching
time between different applications is significantly less.

This section describes the following key aspects of using the MOOXA software.
- High-level Architecture
- Using the GUI
- Using SCPI
- Using a Modular VSA versus a Swept Analyzer
- Triggering and Gating
= Alignments
- Event Logging
= Optimizing Performance

- Additional Information

Help for MO0XA is available from the Start Menu or by pressing F1 while the
application is running. M90XA Help is generated from common files shared
with X-Series Applications because M90OXA Software has been created from the
same code base as X-Series Applications. Not all M9OXA Help files have been
updated to include specific information related to Modular X-Apps or PXI VSA
hardware.

High-level Architecture

This section provides an overview of the high-level architecture of the MI0OXA
software.

The following diagram provides a high-level overview of the MYOXA Software use
model:
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M9I0XA Application Container

The Keysight MOOXA is a container for the X-Series Measurement Applications.
MOI0XA provides features and services which are common to all of the
measurement applications. For example, the graphical user interface, programming
API, utility, and housekeeping functions (such as save, recall, system info, and error
reporting). The AgM90XA is an IVI driver (IVI-COM or IVI-C), however, once the
driver is initialized the measurement applications use a SCPI programming APl and
offers code compatibility with benchtop analyzers.

You can launch the MOOXA Software from the Start menu as described in
Launching MYOXA section. Once launched, make measurements in either of the
following ways:

-~ Interactively by using the MO0OXA GUI

- Programmatically by using the SCPI commands

M9000 Resource Manager

The M9000 Resource Manager allows hardware driver session to be shared by
multiple applications running in the same process without having to close and
reopen a hardware driver session. The supported applications include the M9OXA
Software, 89600 VSA, and customer code. This capability enables high speed
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operations including Adjacent Channel Power Ratio (ACPR) measurement and
power servo routines. In addition, it allows to use the MOOXA Software for
measurements that are not available in the driver such as Error Vector Magnitude
(EVM) and Spectral Emission Mask (SEM).

The M3000 Resource Manager provides arbitration between multiple users based
on a co-operative sharing model. Each time an X-Series Measurement Application
needs to access the hardware driver session, it sends the resource manager a
checkout request, uses the hardware, then immediately checks it back into the
resource manager. Similarly, when you want to use the hardware driver session you
must first check it out from the resource manager. For information related to how
the 89600 VSA accesses the hardware driver session, refer to the 89600 VSA:
Running In-Process and Sharing Hardware Driver Sessions section.

To programmatically access the hardware driver session refer to the Programming
with MOOXA section.

The M9000 Resource Manager has:
~a.NET API

- an unmanaged C API

Supported VSA Hardware

The supported VSA hardware for MOOXA software is M9391A PXle Vector Signal
Analyzer and M9393A PXle Performance Vector Signal Analyzer. For more details
on M9391A and M9393A, refer to http://www.keysight.com/find/M9391A and
http://www.keysight.com/find/M9393A, respectively.

M9391A and M9393A VI Drivers

The MOOXA Software connects to VSA hardware through the M9391A or M9393A
I\VI driver (IVI-COM or IVI-C), which is shipped with the VSA hardware. These drivers
can also be download from the links below:

= M9391A Drivers - http://www.keysight.com/find/M9391A-Driver
~ M9393A Drivers - http://www.keysight.com/find/M9393A-Driver

Using the GUI

Traditional Ul

Use of the M3OXA PC Application is essentially the same as using remote desktop
to interact with a benchtop analyzer's embedded X-Apps software. Right click
anywhere on the application window to bring up menus. A Virtual Front Panel is
available under the Utility menu. The familiar X-Series analyzer softkeys are
included on the PC Application.

Some menus that were applicable only to a benchtop analyzer do not appear in the
M90XA software.
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Touch Ul

The new multi-touch Ul Virtual Front Panel was launched in M9OXA 6.0 release. For
more details, refer to Launching MOOXA.
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Using SCP!

This section describes the SCPI usage of the MGOXA Software.

HiSLIP (High-Speed LAN Instrument Protocol) is recommended for SCPI
connections because it is fast, it supports instrument control features. For
example, Device Clear and Service Request. It also supports multiple
instruments at a single IP address.

SCPI Control of MYOXA- Touch Ul
To view the SCPI 1/0 configuration:

1. Launch the MO0XA Software (Refer to Launching M90XA).
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2. Click on the highlighted drop down arrow in the above image.
The System Settings window is displayed.

System Settings /0 Config

System

sCPI
110 Config

System IDN Response
User Interface

Restore Defaults
Alignments

Licensing

3. In the left panel of the window, select I/0 Config.

System Settings SCPILAN

System
[SCPI Telnet

User Interface
Restore Defaulis

Allgnments HISLIP Server

(hislip0)

Licensing

Verbose SCPI

Device Clear
on Disconnect

4. Set the required SCPI configuration.

SCPI Control of MOOXA- Traditional Ul

Once you have launched M90XA, you can program the measurement applications
by using the SCPI commands.

To view the SCPI I/0 configuration:

1. Launch the M90XA Software (Refer to Launching MIOXA).
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2. Right-click to view the MSOXA Context/Shortcut menu.
3. In the Context/Shortcut menu, select Utility > System.

Ref 20 dBm

Setup
Marker

Control

Mode

Meas

Mode Preset
User Preset

Utility System

Window Save

Quick Save Recall
Return

Page Setup

— Print

Help
Virtual Front Panel
Exit

Center 2.412 GHz Span 25 MHz
Res BW 100 kHz VBW 1 MHz Sweep 1ms

4. Click I/0 Config.

5. Click SCPI LAN.
The SCPI'1/0 configuration appears:
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SCPILAN
-

Use the displayed I/0O configuration information and the IP address or host name of
the computer running the MOOXA software, to determine the VISA resource
address for this instance of the MY0OXA software. For example, if the MOXA shown
above is running on a computer with IP address 192.168.1.1, the full SCPI Socket
addresses is “TCPI PO: : 192. 168. 1. 1: : 5025: : SOCKET”, and the full HiSLIP
address is “TCPI P0O: : 192. 168. 1. 1: : hi sl i p0O: : | NSTR’. Use this resource
address to open a VISA session for sending SCPI commands to the MOOXA.

The MIOXA supports SCPI Telnet, SCPI Socket, and HiSLIP connections, but not
SICL Server (VXI-11) connections.

A tool like Agilent Interactive 10 (part of Agilent Connection Expert) can be used to
test SCPI control. After connecting, the MY0OXA should respond to " | DN?" and "

FREQ CENTER?" commands.
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' =8 Agilent Interactive IO - C

Connect Interact Help

@3] 101 z7
Device Clear Read STE SYST:ERR? | Clear History  Options

=l FREQ-CENTER? ﬂ Commands »

Send Command | Fiead Response | Send & Read |

Instrument Session History:

Connected to: TCPIPO::localhost::-hislipd::INSTR
+“IDN?

Agilent Technologies, MS0XA NA00000000,M_14_00
FREQ:CENTER?

2412000000

For details on measurements to be made for individual X-Series measurement
application, you can refer to the respective documentation available at Start Menu
> All Programs > Keysight > MO0OXA X-Series Applications 24.0 > Help.

HiSLIP

The MOOXA supports SCPI connections using HiSLIP, Socket or Telnet protocols.
HiSLIP (High-Speed LAN Instrument Protocol) is recommended because it is fast, it
supports instrument control features such as Device Clear and Service Request,
and it supports multiple instruments at a single IP address.

HiSLIP addresses include a HiSLIP device name like “hi sl i pO” ending in a HIiSLIP
number. By default, the MOOXA selects the next available number at startup. If two
instances of the MI0XA are started, the second instance will usually be at hi sli p1
. When using a shortcut to StartM90XA.exe to start the MOOXA, this address
uncertainty can be avoided by adding the / hi sl i p command line option with a
large number such as 101. When using the AGM90XA VI driver to start the MOOXA
from a program, the assigned address can be queried by reading the

Hi SLI PVi saAddr ess property.

The M9O0XA SCPI Socket Server must remain On. Do not turn SCPI Socket
Server Off because StartM90XA (version 2.0 and later) requires SCPI Socket
Server to complete the startup. M90XA versions prior to 2.0 require HiSLIP
Server On to complete startup.

SICL Server (VXI-11)

As noted earlier, MOOXA supports SCPI connections using HiSLIP, Socket, or Telnet
protocols. Unlike benchtop instruments, it does not support the SICL Server (VXI-
11) protocol. Not supporting SICL Server enables the MI0OXA to run on a computer
with other instrument applications.
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The recommended TCPIP protocol for MSOXA is High-Speed LAN Instrument
Protocol (HiSLIP). For more information about using HiSLIP, see "Using the TCPIP
Interface Type for LAN Access" in the Keysight |0 Libraries Connectivity Guide.

SICL Server connections are typically established with a VISA resource string
ending in ::instrO::INSTR. Controlling programs can be changed to use HIiSLIP by
changing the VISA resource string to end in ::hislip0::INSTR (for example).

Using a Modular VSA Versus a Swept Analyzer

This section describes some of the differences when using X-Series Applications for
Modular Instruments versus using swept-tuned analyzers, as in case of Benchtop
instruments.

- Power Range
- Spectrum Measurements
- Stepped FFT vs Swept-tuned for Spectrum Measurements

- Image Protection

Power Range

X-Series benchtop analyzers (MXA, PXA) typically have an amplitude (Y Scale)
setup menu that controls the analyzer's internal attenuators, preamp, and IF Gain.
The amplitude level is controlled using RF attenuation, preamp, and IF gain
commands as shown below:

: PONer[: RF]: ATTenuati on <atten>

: PONer [ : RF] : EATTenuat i on <atten>

: PONer[: RF]: GAI N[ : STATe] OFF| ON

;1 F: GAIN: FFT: [ : STATe] AUTOr ange| LOW HI CH

M9I0XA with modular PXI VSA hardware has an amplitude setup menu with a range
entry. Select the peak power level expected to be present at the PXI VSA input and
the application will optimize the internal attenuators for that expected input level.
On the X-Series Measurement Applications for Modular Instruments, amplitude
level is controlled using the Range command:

: PONer : RANGe <dBne
This command sets the expected input power (peak) in dBm.

Sending Attenuator commands to the MOOXAcan cause an "Undefined header"
error and have no effect on amplitude. Most applications can be updated by
mapping 0 dB attenuation to -10 dBm Range, 20 dB attenuation to +10 dBm
Range, and so on.

Spectrum Measurements

Stepped FFT vs Swept-tuned for Spectrum Measurements

- X-Apps on Keysight X-Series benchtop analyzers (MXA, PXA) utilize the
instrument's Spectrum Analyzer architecture:
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- Swept-tuned data acquisitions (Spectrum measurements) operate by
sweeping an LO through the frequency range of interest, acquiring
spectrum data as it sweeps.

- Time data acquisitions (IQ measurements) set the LO to a fixed
frequency and acquire time-record data.

- X-Apps on Keysight Modular PXI Instruments utilize the modular
instrument's architecture to acquire spectrum and time data. In the case of
a VSA (Vector Signal Analyzer) instrument:

- Time data acquisitions (IQ measurements) use a fixed LO, the same
as in a Spectrum Analyzer.

- Spectrum data acquisitions (Spectrum measurements) are acquired
by collecting and converting time data to spectrum data using FFT
techniques. If more spectrum data is needed than the acquisition
bandwidth supports, multiple FFTs are acquired and stitched
together to form the wider span spectrum.

- For Spectrum Measurements on Keysight Modular PXI Instruments, Sweep
Time is interpreted as “Equivalent Sweep Time”, such that the measurement
results will have equivalent variance within an RBW as that of a
measurement made using swept hardware. Actual acquisition times are
typically much shorter than the Equivalent Sweep Time value. Use Gate
Length if a specific acquisition time is needed.

Image Protection

Modular instrumentation uses different frequency downconversion techniques,
resulting in some differences in mixer image protection.

Analyzers use super heterodyne techniques, where input signals are shifted to
lower frequencies using one or more mixers. Without any filtering or image
suppression signal processing, the analyzer responds at both the desired frequency
and also at an image frequency. The image-susceptible frequency range is typically
400 MHz to 800 MHz above or below the analyzer center frequency. To optimize
measurement speed, modular analyzers use different image protection techniques.

- The X-Series benchtop analyzers (MXA, PXA) utilize fixed filtering below 3.6
GHz, and a YIG-tuned preselection filter above 3.6 GHz.

- Below 3.6 GHz all measurements are image protected.

- Above 3.6 GHz measurements are image protected only when the RF
preselector is on. There is no image protection when the RF
preselector is bypassed. Modulation accuracy usually bypass the
preselector and so are susceptible to images.

= The M939TA Modular PXI analyzer can be configured to use single mixer
conversion mode without image protection, or image-protected double
conversion mode. For best EVM and phase noise performance, the X-apps
use the single mixer conversion mode for all measurements except Spurious
Emissions. Spurious Emissions uses image protected double
downconversion mode.
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- The M9393A Modular PXI microwave analyzer utilizes fixed filtering below
3.6 GHz, and may be configured to use image suppression signal processing
above 3.6 GHz.

- Below 3.6 GHz all X-app measurements are image protected.

- Above 3.6 GHz X-app measurements are not image protected, with
the exception of Spurious Emissions (all modes) and the WLAN 80+80
Spectrum Emissions Mask measurement.

= The Spurious Emissions measurements and the WLAN 80+80
Spectrum Emissions Mask measurement are always image protected
using image suppression signal processing. This technique performs
multiple acquisitions at each frequency and is described in
application note Achieving Excellent Spectrum Analysis Results Using
Innovative Noise, Image and Spur-Suppression Techniques
http://literature.cdn.keysight.com/litweb/pdf/5991-4039EN.pdf.
Because multiple acquisitions are combined (see Figure 7 of the
note), this technique requires the use of gating when measuring burst
signals, and requires a low video bandwidth value to reduce the
variance of time-varying signals.

When making measurements without image protection, insure the signal at the
analyzer input does not include power in the image-susceptible frequency range.

The Monitor Spectrum measurements may not be image protected. One purpose of
Monitor Spectrum is to show the spectrum of the input signal under the same
setup as other measurements like Modulation Accuracy. Contact Keysight support
if your application requires Monitor Spectrum measurements with image
protection.

Triggering and Gating

This section provides the information about the capabilities of Trigger and Gating.
The Trigger and Gating capabilities may differ according to the capabilities of the
underlying hardware, since:

- PXI VSA trigger hardware is not identical to the trigger hardware in the X-
Series benchtop analyzers

- PXIVSA is Fixed or Stepped FFT and not Swept-tuned for spectrum
measurements

Trigger Differences

This section lists the trigger capability differences between X-Series Measurement
Applications for Benchtop Analyzers vs. X-Series Measurement Applications for
Modular Instruments. The following table compares the X-Series benchtop analyzer
trigger sources to modular instrument trigger sources.
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Trigger  X-Series M9391A and M9393A VSA Modular Instruments
Source Benchtop
Analyzer

Free Run  Supported  Supported

Video (IF  IF signal IF signal Level; uses the driver's Magnitude Trigger mode
Envelope) level

Line Power line Not available

External ~ "Trigger 1 "Trig 1" on M9214A IF Digitizer PXI module
1 In" on rear
panel

External ~ "Trigger 2 Chassis backplane PXI TRIG 2 line

2 In" on rear
panel
RF Burst  RF Uses the M3391A Wideband Magnitude Trigger mode with 80 MHz of trigger

(wideband)  bandwidth, or the M9393A Wideband Burst Detector with at least 200 MHz of
signal level  trigger bandwidth.

Periodic ~ Supported  Supported (see note below)
Timer
(Frame)

External 1 Trigger

"External 1" uses the MO214A Digitizer module "Trig 1" port as an external trigger
input. Level, slope, and delay can be set. This input is not configured to provide a
50 ohm termination.

External 2 Trigger

"External 2" uses a PXI chassis backplane trigger as an external trigger input. The
specific trigger line used is TTL TRIG 2. Slope and delay can be set. Level is
ignored. To use this in a PXI system, configure another PXI module to drive TTL
TRIG 2. The chassis trigger bus routing must also be configured if the modules are
located in different chassis trigger bus segments.

RF Burst Trigger

"RF Burst" uses the M9391A VSA Wideband Magnitude trigger mode which can be

used to trigger from a burst signal when tuned to measure in an adjacent frequency
channel. With M9391A VSA the bandwidth of this trigger detector is 80 MHz, which
is less than the RF Burst trigger bandwidth of most X-series Benchtop analyzers.
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With M9393A VSA the bandwidth of this trigger is at least 200 MHz which is the
same as most X-series Benchtop analyzers.

Operation of the M9393A burst trigger requires the use of a PXI backplane trigger
line (usually PXI_TRIG 5), from the M9365A Downconverter module (where the
detector is located) to the M9214A Digitizer module. If these modules are located
in different PX| backplane trigger bus segments, a trigger route must be
configured. When running in a M9018A chassis the MIOXA software will
automatically configure trigger routing when the software is started. If the system
requires use of different trigger line, the line can be specified in the Advanced
Options of the stored hardware configuration (or alias). For example,
"BurstTriggerLine=5" will use PXI_TRIG 5.

Periodic Timer (Frame) Trigger

Periodic Timer (Frame) trigger is supported, with differences in synchronization
behavior. On modular hardware, if Sync Source is set to a trigger source, the next
measurement will always wait for that trigger event to re-synchronize before
completing the measurement. On X-series Benchtop analyzers in this same setup,
measurements do not wait to re-synchronizing if the Periodic Timer trigger was
previously synchronized. This can be noticeable when synchronizing to a 1 pulse-
per-second external trigger. It can be avoided by setting Sync Source to Off after
synchronizing the first measurement.

Gating

Many X-series applications have support for Gating under the Sweep/Control key.
This is important when measuring burst signals and when the measurement time is
longer than the duration of a single burst. In a traditional swept-tuned analyzer,
gating suspends the sweep between bursts. In a fixed-tuned modular analyzer,
gating controls the trigger source and acquisition length of individual acquisitions.
It is per-acquisition triggering. The Gate Source can be External 1, External 2, RF
Burst, or Periodic Timer.

If Gate is On, but a valid gate/trigger is not present, the analyzer will display
"Waiting for Trigger". If you see "Waiting for Trigger", and the analyzer trigger is
configured for Free Run, remember to check the Gate settings.

Trigger Outputs

When using the M9391A or M9393A VSA modular hardware, the following trigger
outputs are available. These outputs produce a 10 ps TTL pulse when the event
occurs. A single measurement may perform multiple acquisitions and cause
multiple pulses to be output.

Trigger Function M9391A VSA M9393A VSA

Output Connector Location Connector Location

Armed Pulses when the analyzer isarmed and ~ Trig 2 on M9350A Trig 2 on M9365A
ready to receive a trigger. Downconverter module ~ Downconverter module
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Trigger Function M9391A VSA M9393A VSA
Output Connector Location Connector Location
Trigger Pulses when the analyzer has started an ~ Trig 2 on M9214A IF Trig 2 on M9214A IF

Received acquisition.

Acquisition  Pulses when the acquisition is
Complete  complete.

Digitizer module

Trig 2 on M9301A
Synthesizer module

Digitizer module

Trig 2 on M9308A
Synthesizer module

Alignments

This section provides information about M3OXA alignments.

Turning Off Auto Alignments

Since alignments of M9391A or M9393A PXle Vector Signal Analyzers can require
anywhere from several seconds to a few minutes to complete, it is recommended
that for automated test applications, auto alignments be turned off.

The SCPI command to turn off auto alignments is:

CAL: AUTO OFF

For M90XA, CAL: AUTO PARThas the same behavior as CAL: AUTO OFF.

Automated test applications can use the calibration expired query to check for &
perform an alignment as needed:

CAL: EXP?

This command is a blocking query; thus, it requires a VISA timeout that is longer
than the longest alignment time.

M9393A Alignments

The M9393A PXle Vector Signal Analyzer alignment requires that no signal be
present at the analyzer's RF input. When an alignment is attempted, M9OXA
performs a check for power at the input. If a signal is detected, the alignment is
skipped and an error "Align Now; RF Required" is posted to the MOOXA GUI and
Error Log. The MOOXA Error Log and the M9000 Event Log also reports that the
alignment was skipped. An automated test applications should ensure no that the
power is applied to the M9393A RF input before sending CAL: EXP?,

Event Logging

The event logging information is available as entries in the Windows Event Logger.
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Events from the M3000 Resource Manager are logged under Applications and
Services Logs -> Agilent M9000 Measurement Framework

{2] Event Viewer (Local)
:..F' Custom Views
» Lm Windows Logs
a [ Applications and Services Logs
i | Agilent M3000 Measurement Framewaork
& AgilentlOLibraries
'.—| Hardware Events
| HP HotKey Support
&| HP Software Framework
&+| Internet Explorer
'.—| Key Management Service
= Media Center

Events from the MOOXA X-series Measurement Applications are logged under
Applications and Services Logs -> SA

| Microzoft-5QLServerDataToolsVs
| PreEmptive

=5

] Symantec Endpoint Protection Client
5] Testify

Optimizing Performance

This section provides techniques for optimizing performance of MOOXA.

PXle Chassis Configuration

Depending on your model of chassis and type and model of controller, you might
be able to achieve additional measurement speed by modifying the PCle Link
Configuration of the chassis.

For more information, refer to chassis User Guide.

Controller Configuration

Windows Operating System

You may be able to improve performance by optimizing settings under the
Windows Control Panel.

- Power Options: Verify that a High Performance Plan is selected and that
Processor Power Management is set to 100% for Minimum and Maximum
Processor State.

Controller BIOS

Your controller's BIOS may have CPU settings that favor efficient use of power over
maximizing performance. You might see performance improvements after disabling
these energy conservation features.
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Additional Information

This section describes additional items to be aware of when using MO0OXA with the
M9391A or M9393A PXle Vector Signal Analyzer:

M9063A Analog Demod

- The "Demod to Speaker" feature that enables a demodulated audio signal to
connect to the speaker is not supported.

M90B9A Noise Figure

- A 346CHQ08 USB adaptor is required to connect the 346x noise source to the
USB controller port for driving the noise source.
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Programming with MY0XA

The MIOXA Software includes several example programs that illustrate the SCPI
usage of the MOOXA Software and the shared usage of the M9391 or M9393 VI
Driver session. For more details, refer to Using SCPI section for basic information
related to SCPI usage.

M9IO0XA Example Programs

Each of the example programs describes how to perform the following tasks:
= Open an M9000 Resource Manager session.
- Create a sharable M9391 or M9393 IVI driver session.
- Start the M90OXA Software.

- Quickly switch between the X-Series Measurement Applications and direct
access to the driver by sharing the IVI driver session.

The example programs can be accessed via Start Menu > All Programs > Keysight >
MOIO0XA X-Series Applications 24.0 > Examples > Open Examples Folder. Following
are the example folders:

Folder Sub-folder name Language M9391 M9393 Description

Name

LabVIEW  LabVIEW 2017 LabVIEW : LabVIEW Example

LabVIEW  LabVIEW 2013 LabVIEW : LabVIEW Example

VS.Net AnsiC > C_UsingM9391 C/C++ . C or C++ Example

VS.Net AnsiC > C_UsingM9393 C/C++ : C or C++ Example

VS.Net CSharp > CS_ExampleForm NET (C#) . . C (Sharp) Example Form

VS.Net CSharp > NET (C#) . . C (Sharp) Example Form

CS_ExampleFormWith89600 with 89600

VS.Net CSharp > CS_UsingM9391 NET (C#) . C (Sharp) Example

VS.Net CSharp » CS_UsingM9393 NET (C#) : C (Sharp) Example

VS.Net VB > VB_UsingM3391 Visual Basic. - Visual Basic .Net Example
Net

VS.Net VB > VB_UsingM9393 Visual Basic . : Visual Basic .Net Example
Net
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1. Before compiling an example program, you should first copy the
example folder to another location that you will use for development.
This ensures that you always have access to the original examples.

2. Before running an example program, you should be able to manually
launch the MOOXA Software using a configured M9391 or M9393 driver
session name (refer to Launching M90XA). This configured driver
session name (or alias) is used in the .NET and LabVIEW example
programs to programmatically open the M9391A or M9393A driver
session.

- For programming documentation on the M3000 Resource Manager's .NET
APl and unmanaged C API, refer to their respective documentation available
at Start Menu > All Programs > Keysight > Keysight M9000 Measurement
Framework.

- For programming documentation on the MSOXA VI drivers, M9391 VI
drivers, and M9393 VI drivers, refer to their respective documentation
available at Start Menu > All Programs > Keysight Instrument Drivers.

Shared Native .dlls

When running one or more applications in a single process space, it important that
the loaded version of a shared native (unmanaged) .dll be one that meets the
requirements of all the applications in the process. Without intervention, the first
application to load a .dll may load a version that is older than what is needed by
other applications in the process.

To address this need, the M9000 loads shared native .dlls when M9000 session is
opened. The MI000 loads the shared native .dlls from the following folder:

- 64-bit application: C:\Program Files\Agilent\M3000\24.
O\Core\CommonfFiles

Usage Notes:
= You can put newer versions of shared .dlls in this folder if needed.

= A “repair” of the MYOXA install restores the .dlls to the original versions that
is shipped with MYOXA.

= Any issues with loading shared .dlls is reported in the M900O Event Log.

- If a .dllin this folder is newer than the one used by another application in
your process, then the application must start before M9000 session is
opened. You may copy the newer .dll to your application’s folder (from which
the older version .dll is being loaded).
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LabVIEW Example

In the LabVIEW folder available in the Examples directory (C:\Program
Files\Agilent\M90OXA\24.0\Examples\LabVIEW), you can find the example code for
the 64-bit version of National Instruments’ LabVIEW (versions 2011 and 2013).
Copy the example folder to another location that you use for development. This
ensures you always have access to the original examples.

Prerequisites

Before you execute the examples, it is required to switch to the .NET Common
Language Runtime (CLR) for LabVIEW to version 4.0. This is not a standard
configuration for LabVIEW. You can refer to the detailed instructions for this at the
National Instruments’ website - http://zone.ni.com/reference/en-XX/help
/371361J-01/lvhowto/configuring_clr_version.

Executing the LabVIEW Example

1. Double-click the M9000_LabVIEW.lvproj file available from the location
where you copied the example code. The Project Explorer page appears:

8 Mo000_LabVIEW.lvproj * - Project Explorer e B
File Edit View Project Operate Tools Window Help

' eS| % |8 b | B~ o ||
Items | Files

= (&g, Project: M9000_LabVIEW.lvproj

= B
- (sl MO00D_LabVIEW.vi

_'5; Dependencies
i e Build Specifications

|

*
=

2. Double-click the M9000_LabVIEW.vi file on the Project Explorer page to
open the VI.
The ApiExample_LabView.vi Front Panel appears, with a Load Warning
Summary pop-up.
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{3 Load Mfarning Summary

": Withile loading ApiExam ple_LabWIEW.vi, LabVIEW reported 3 wearnings:

- .MET assernbly changed (3 warnings)

- Click Show Details for more information,

To wiew warning details later, select View = » Load and Save Warning List.

Shoy Details ][ Ignore ][ Help

3. Click Show Details.
The Load and Save Warning List window is displayed.

43 Load and Save Warning List

[E=E 5o/

History
171272017 11:49:21 AM -~ Loaded ApiBxarnple_LabWIEW i
Details for Top-Lewvel Itern
Loaded from path: C:\Program Files (x86)\AgilentiMO0XALS.00ExamplesA\LabVIEWLabVIEW 2013\ApiExample_LabVIEW.vi
el
1

Types | Itemns

Warning Types

MET assembly changed (3 warnings)

Details

ChProgram Files (A6 AgilentihI0ANS, MhExarmples\LabVIEWALabWIEWY 20130 ApiExarnple_LabWIEW wi (ApiExample_LabWIEW wi)

- Expected Assernbly "Agilent.Agh9391Interop, Version=1.2.252.0, Culture=neutral, PublicKeyToken=cedT8d295d1e0f2b", but
found "Agilent.Aghd9391 Interop, Wersion=2.1.230.1, Culture=neutral, PublickeyToken=ced72d295d1e0f2b."

- Expected Assembly "Agilent.Agh30A Interop, Wersion=2.1.32.0, Culture=neutral, PublicKeyToken=ced73d295d1ef2b", but
found "Agilent.Agh90xAInterap, Wersion=5.0.23.0, Culture=neutral, PublicKeyToken=ced78d295d1e0f2b."

- Expected Assembly "Agilent. 3000, Version=2.1.32.0, Culture=neutral, PublicKeyToken=ced78d205d1e0f2b", but found
"Agilent,MI000, Wersion=5.0,23.0, Culture=neutral, PublicKeyToken=ced78d295d1e0f2b."

Two warnings may appear (as displayed below) about the changed .NET

assembly versions. You may ignore these warnings and click Close.

4. The front panel of the M3000_LabVIEW.vi has a single input field called
requiredResourceName. Enter the resource configuration name, which you
have specified earlier (for example MyVSA, or M9391), during launching of
M3IOXA, in the requiredResourceName field.

5. Check Simulate, if you want to simulate the hardware.

6. Click Run to run VI.
This launches the GUI of the M90OXA Software.
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7. Click STOP on the front panel of the M3000_LabVIEW.vi to close the MOOXA
GUL
This also stops the LabVIEW example.

The LabVIEW Example Code

When you access the Block Diagram by using the MS000_LabVIEW.vi Front Panel,
you can view the example code:

55 MSD0O_LabVIEW i Block Disgram on M300O_LabVIEW.ivproj/My Computer * |
File Edt View Project Operate Tools Window Help
[0 [@][g5] [wa =] 2| [15pt Application Font |~ |3+ |4~ [ Search 17

g Tass S = Agl
p__ ActiveMode | [ HiSLIPV:

HisLIRViszAddress

[M9000_LobVIEW Ivproj/My Computer <

This example code consists of a sequence of Invoke Nodes that call methods on the
AgMO0XA VI driver as well as the M9000 API.

SCPI strings can be used to make measurements using the M90XA Software.

For more details, refer to the respective APl documentation.

C or C++ Example

The C_UsingM939T7 and C_UsingM9393 example folders contain C/C++ example
programs. These programs show the procedure to call M9000 and MSOXA library
functions from unmanaged (or native) Windows programming environment.

- C_UsingM939T is used with the M9391 hardware

- C_UsingM9393 is used with the M9393 hardware
The steps below are for the M9397 but can be applied to the M9393.
This example is a console program that performs the following steps:

1. Open an M9000 session. This can be used to manage the sharing of VSA

hardware and driver resources.
Use the M9391 IVI-C driver to open a VSA driver session.
Add the VSA driver VI session to the M9000 resource pool.
Use the MIOXA IVI-C driver to open a MOOXA application.
Lock the VSA driver resource for use by this program.

Use the driver C functions to measure channel power.

N o o~ wDN

Unlock the VSA driver resource.

Keysight MOOXA X-Series Measurement Applications for Modular Instruments 50



57

8. Use the M90OXA application to measure modulation accuracy.

9. Close driver sessions.

Building the C/C++ Example
To open this example, first copy the example folder files from the installed location

to a temporary folder (for eg, C:\Temp).

1. Open the C_UsingM3939T project file with Microsoft Visual Studio.

This example supports Microsoft Visual C++ 2010, so you might be
prompted to update/upgrade the project.

2. Open the source code C_UsingM9391.c and review the code.

3. Build the C_UsingM93917 project.
Compiling requires several .h include files that are installed by the MOOXA software,
M9391 driver, and VISA (from Agilent |0 Libraries). These are found through
environment variables such as /VIROOTDIR32 and VXIPNPPATH which are set by

the installers. Linking requires these same environment variables to find library
files.

Running the C/C++ Example

You can either run the program from within Visual Studio, or find the .exe and
execute it.

The following output appears:

i Chtmp\Examples\C_UsingM9391\Win32\Debug\C_UsingM9391.exe [E=REE

C_UsingM?391
Example of using the Keysight M?888 API with the M?391 USA.
Runs in simulated mode if no command line parameter is provided.
Run with resource string argument to use harduware.

m | »

Initializing M?888 Modular Applications library...

Initializing M?3?1 USA driver using resource name "MyUSA' ...

USA driver initialized.

USA driver session added to the M?B08 resource pool.

Starting M?88A application wusing the same USA driver...

Opening SCPI connection to M?BXA at address ‘TCPIPBA::5CB31200Q4::hislipB:=:INSTR'

Locking the USA driver resource for IUVI-C use.

Meazuring channel power by calling USA IUI-C driver functions.
Measured power —38.43 dBm at 1000.88 MH=

Unlocking the USA driver resource to allow MP?BXA to use it.
Measuring modulation accuracy with M?8EA. ..

Measured EUM: 9299 average,. 999 peak

Done — Press Enter to Exit_

In addition to the above, the M90OXA Software Ul appears.
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In case you have not specified any command line parameters, the program will
use simulated hardware.

To run the program with M9391A hardware:

1. Use the M9391 SFP to select PXI modules.
2. Save the configuration with a name such as, MyVSA or M9391.

Provide this name as a command line parameter.

Deploying a C/C++ Program

Although this is a native C/C++ program, running the executable requires M9OXA
and M9391 drivers to be installed, which require version 4 of the .NET Common
Language Runtime. The app.config file (as displayed below) has a startup
configuration to allow interoperability with older components that were developed
for Version 2 of the CLR.

If you are starting from scratch and an app.config file does not exist in your
solution, right click on the startup project name and select add new item. From the
list of Visual C# items, select “Application Configuration File.” Copy the following
text into the App.config file:

<?xm version="1.0""?>
<configuration>
<startup uselLegacyV2Runti neActi vati onPolicy="true">
<supportedRuntime version="v4.0" sku=".NETFranmeworKk,
Ver si on=v4.0" />
</startup>
</ confi guration>

If you are modifying an existing solution you may need to add the startup setting to
the configuration section of the existing solution's app.config file.

C (Sharp) Example

This section covers the CS_Using examples provided with the MYOXA Software.
Two console application example programs are provided, one for use with the
M9391, and another for use with the M9393. The steps below are for the M9391
but can be applied to the M9393.

Copy the example folder to another location that you will use for development.
This ensures that you always have access to the original examples.

In the CS_UsingM9397 folder, double-click the CS_UsingM9391 project file to open
it in Visual Studio.
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References

This example references the assemblies as displayed below:

Solution Explorer * 1 X

j Solution 'C5_UsingM9391" (1 project)
4 [ C5_UsingM9391
=d| Properties
4 | 7 References
<3 Agilent. AgMODKAInterop
<3 Agilent.AghO301 Interop
-+ Agilent.MI000
3 Ivi.DriverInterop
A3 Ivi.VisaInterop
2 Systern
A Systern.Core
% app.config
#] Program.cs

Assembly Purpose

Copy Local

Agilent. AgMO0XA.Interop  The Agilent MIOXA IVI-COM driver

Agilent. AgM9391.Interop  The Agilent M9391 IVI-COM driver

Agilent.M9000 The Agilent M9000 Application Framework
Ivi.Driver.Interop For IVI driver communications
Ivi.Visa.Interop For SCPI communications

App.Config

False

False

False

False

False

The Agilent M9000 Resource Manager uses version 4.0 of the .NET Common
Language Runtime. The app.config file (as displayed below) has a startup
configuration to allow interoperability with older components that were developed

for Version 2 of the CLR.
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ea ApiExample - Microsoft Visual Studio

File Edit View Project Build Debug Team XML Data Tools Test Window Help

e Ful- W@ % AB[R=2(9-0¢-S-B[r nusEE

Cal Ry (el Source Control Explorer Object Browser

k#xml version="1.8"%>
—l<configuration:
-] «<startup uselLegacyV2RuntimelctivationPolicy="true">
<supportedRuntime version="v4.8" sku=".NETFramework,Version=v4.8" />
</startup:>
</configuration:

If you are starting from scratch and an app.config file does not exist in your
solution,

1. Right-click on the startup project name.

2. Select Add New.

3. From the list of Visual C# items, select Application Configuration File.

4. Copy the following text into the App.config file:

<?xm version="1.0"?>
<configuration>
<startup useLegacyV2Runti neActi vati onPolicy="true">
<supportedRuntime version="v4.0" sku=".NETFrameworKk,
Ver si on=v4.0" />
</startup>
</ confi guration>

If you are modifying an existing solution, you may need to add the startup setting to
the configuration section of the existing solution's app.config file.

Code Walkthrough

1. Open a session to the M9000 Resource Manager.

OpenM900BSession

try

{
_nyMB000Sessi on = Sessi onFactory.
OpenMB000Sessi on() ;

}
catch (Exception e)

{
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Consol e. WitelLine("Could not start MP0O0OSessi on
(details follow.");

Consol e. WiteLine(e.ToString());

Wi t For User () ;

C eanup();

return 1;

}
Consol e. Wit eLi ne("MB000Core sucessfully started.");

2. Create a sharable M9391 IVI driver session.

OpenSharableResource

/1l Open the IVl driver as a sharabl e resource

var result = myM000Sessi on. OpenShar abl eResour ce
(Resour cePl ugi nType, _iviAlias, out _resourceNane,
simul ate) ;
if (result != ResourceManager Resul t. (k)
{

Consol e. WiteLine("Could not open sharabl e
resource of type '" + ResourcePl ugi nType

+ "' using alias '" + _iviAlias + "'. \n"

+ result.ToString() +". See Wndows Event Log.");

Wi t For User () ;

C eanup();

return 2;
}

3. Start the M90XA Software.

M90XA.Initialize

try

{

Consol e. WiteLine("Starting the MBOXA, please
be patient.");

[l Start the MDOXA

_myMBOXA = new AgMBOXA() ;

}
catch (Exception e)

{

Consol e. WiteLine("Could not instantiate the
MBOXA (details follow).");

Consol e. WiteLine(e. ToString());

Wai t For User () ;

C eanup();
return 3;
}
string iviOptions = "Sinul ate=true";
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string optionString = iviQptions;
try

{
_myMBOXA. I nitialize(_resourceNane, false, false,
optionString);

}
catch (Exception e)

{

Consol e. WiteLine("Could not initialize the
MBOXA (details follow).");

Consol e. WiteLine(e. ToString());

Wai t For User () ;

C eanup();

return 3;

4. Switch between the M90XA Software and direct access to the M9391 driver
session by sharing the M9391 VI driver session.

The private method Usel vi Dri ver () shows how to checkout the hardware
driver from Agilent M9000 Resource Manager, use it, then check-in back so
that it is available for use.

Checkout

#regi on Check-out (lock) IVI HWdriver for use

MBOOOResour ce mBO0O0OResour ce;
i f (_myMB000Sessi on. Checkout (_resour ceNanme, out
nMB000Resource) ! = Resour ceManager Resul t. Ck)

{

Consol e. WiteLine("Could not checkout driver
resource '{0}'", _resourceNane );

Wi t For User () ;

return 1;

}

/[l Cast it to the type you asked for
var driver = (1 AgMP391) nBOOOResource.|tem

Consol e. WiteLine("\nDriver is available for use.");

#endr egi on

Use IVI

#region Use IVI HWdriver resource

/'l Note that if we are doing multiple checkout
/ checkin we may be able to skip
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/1l sone setup stuff if we know we were the | ast
user.
i f (!nmBO00OResource. St at eQuesti onabl e)

{
Consol e. WitelLine("No one used the driver since
we | ast unlocked it.");

}

driver. Rest or eDef aul t Properties();
driver. Acqui siti onMbde = AgMB391Acqui si ti onMbdeEnum
AgMB391Acqui si ti onModePower ;

driver. Power Acqui si tion. Configure( 10.0e6 /* MHz BW
*/, 1.0e-3 /* seconds duration */ );

driver. Appl y();

driver. Arm();

doubl e power = -200.0;

bool overl oad = fal se;

driver. Power Acqui siti on. ReadPower ( O,
AgMB391Power Uni t sEnum AgMP391Power Uni t sdBm r ef
power, ref overload );

Consol e. WiteLine("IVI driver power measurenent
result: {0: A} dBm', power);

#endr egi on

Checkin

#regi on Check-in (unlock) IVI HWVdriver so others
may use it

_myMB000Sessi on. Checki n( M000Resour ce) ;
Consol e. WiteLine("\nDriver checked in, ready for
use by others");

#endr egi on

Internally, the M9OXA is also checking out the same resource, using it, and
checking it back in.

C (Sharp) Example Form

This section covers the CS_Exampleform programming example provided with the
MO0XA Software.

The following example shows, how to create the Windows Form application to start
the MOOXA Software:

1. Select a specific X-series application.

2. Perform band power measurements with the M90OXA.
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3. Perform band power measurements with the IVI driver.

The code for this example is similar to the CS_UsingM93917 or CS_UsingM9393
console program.

In addition to source code, a compiled exe is installed. To run the exe:

1. Go to Start > All Programs > Keysight > MOOXA X-Series Applications 24.0 >
Examples > CS_ExampleForm (64-bit).
The program first prompts to open the M9391 or M9393 driver session based
on an VI driver Name, and a saved hardware configuration Alias.

r |

o CS_ExampleForm - Keysight MI00O =NACN X
IV Driver
Name | Agh9391 -|
Aias | MyVSA - | Open SFP...

Simulation Mode

[ 1: Open Session l Session Status

1e6 001

2. Click Open Session to open the driver session.
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o5l C5_ExampleForm - Keysight M3000

=@ =

AgMi391

MyWSA

Keysight X-Seres Measurement Applications

[

2: Start MO0XA

| mooxastatus

3. After the shareable IVI resource session is opened, you may use the driver

directly as illustrated by the band power measurements.

You may also start the MOOXA software by clicking the Start MOOXA.

4. After the MOOXA Software is launched, you can use the Select Active App to
switch between the different X-Series Measurement Applications.

P

-l Select Active App

1w CDMA

1 CDMAZEK.

BT

| COMATHEY

) TDSCOMA,

~ ADEMOD

1 NFIG

| wLAN

| WS,

I LTEATDD

1 LTEAFDD

1 PHOISE

) EDGEGSM

[= ][ ]

Select

[ Cancel
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5. In the “Hardware Sharing Example: Band Power” area, click the Using X-App
to send commands to the MIOXA to perform a band power measurement.
This is not supported in some X-series applications, so you may need to first
switch to WLAN.

6. Click Using IVI Driver to perform a band power measurement.

H-bpp Uzage Examples

| SwitchActive dpp... | | ToggleAppVisiity | | Open SCPlwindow |

Hardware Sharing Example: Band Power

Center Frequency [Hz] 29 Fepeat |1 =
Bandwidth [Hz) 1eb Integration Time [Sec) 001
U zing *-4pp ] [ Using Il Diriver
V1 driver: -10.19 dBm -

H-bpp: 1019 dBm
Habppe 10023 dBm
Il driver. -10.128 dBm
wabpp: 10027 dBm
Il driver, 10,18 dBm

Code Walkthrough

To review or modify this program, make a copy of the VS.Net folder, then open the
project file for this example in Visual Studio.

The project has the same assembly references and app.config requirements as the
C (Sharp) Example console programs.

Use Visual Studio to View Code in Mainform.cs in the CS_ExampleForm project.
Near the beginning of this file are some #define directives for each supported VI
driver. Unless you have all the IVI drivers installed, you need to delete or comment-
out directives for IVI drivers you are not using.

ApiExampleForm Code

#defi ne MP391 SUPPCORTED // renove this line to conpile
wi t hout the MB391 IVI driver.
#defi ne MB393 SUPPORTED // renove this line to conpile
wi t hout the MB393 | VI driver.

#i f MB391 SUPPORTED

/1 This "using' requires installation of the M391
IVI driver. Disable if not needed.

usi ng Agil ent. AgM3391. | nt er op;
#endi f

#i f MB393 SUPPORTED
[l This "using' requires installation of the M393
IVI driver. Disable if not needed.

Keysight MOOXA X-Series Measurement Applications for Modular Instruments 60




usi ng Agil ent. AgMB393. | nt er op;
#endi f

usi ng System

usi ng System Di agnhosti cs;

usi ng System d obal i zati on;

usi ng System W ndows. For ns;

usi ng System Col | ecti ons. Ceneri c;
usi ng Agil ent. M00O;

usi ng Agil ent. MB00O. I nt erfaces;
usi ng lvi.ConfigServer.|nterop;
using lvi.Visa.lnterop;

using Mcrosoft.Wn32; // need Agilent. AgMBOXA. | nt er op
ref erence

usi ng Agi |l ent. AgMBOXA. | nt er op;

Other portions of this example are similar to the C (Sharp) Example console
application.

Visual Basic .Net Example

This section covers the Visual Basic .Net examples provided with the M9OXA
Software. Two console application example programs are provided, one for use
with the M9391, and another for use with the M9393. The steps below are for the
M9391 but can be applied to the M9393.

To open this example, first copy the example folder files from the installed location
to a temporary folder (for eg, C:\Temp). This ensures that you always have access
to the original examples.

References

This example references the following assemblies:

Assembly Purpose Copy Local
Agilent. AgMO0XA.Interop  The Agilent MIOXA IVI-COM driver False
Agilent. AgM938x.Interop  The Agilent M938x IVI-Com driver False
Agilent. AgM9391.Interop  The Agilent M9391 IVI-COM driver False
Agilent.M9000 The Agilent M9000 Application Framework False
Ivi.Driver.Interop For IVI driver communications False
Ivi.Visa.Interop For SCPI communications False
App.Config
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The Agilent M3000 Resource Manager uses version 4.0 of the .NET Common
Language Runtime. The app.config file (as displayed below) has a startup
configuration to allow interoperability with older components that were developed
for Version 2 of the CLR.

useLegacyV2Runt:
edRuntime vers.

".NETFramework,Version=v4.8" />

the logging configuration for My.Application.log -->
switchName="DefaultSwitch">

ow section to write to the Application Event Log -->
ntlog™/>-->

value="Information” />

.6.6.9, Culture=neutral, PublicKeyToken=b@3fS5f7f11ds@asa, processorArchitecture=MsIL”

Application Event Log -->

If you are starting from scratch and an app.config file does not exist in your solution,
create one and copy the following text into the App.config file:

<?xm version="1.0" encodi ng="utf-8" ?>
<configuration>
<startup uselLegacyV2Runti neActi vati onPolicy="true">
<supportedRunti me version="v4.0" sku=".NETFramework,
Ver si on=v4. 0" />
</startup>
<syst em di agnosti cs>
<sour ces>
<I-- This section defines the |ogging
configuration for My.Application.Log -->
<sour ce nanme="Def aul t Source" sw t chNane="Def
aul t Swi t ch" >
<listeners>
<add name="Fil eLog"/ >
<I'-- Uncomrent the bel ow section to
wite to the Application Event Log -->
<l --<add nane="Event Log"/>-->
</listeners>
</ source>
</ sour ces>
<swi t ches>
<add nane="Defaul t Swi tch" val ue="Informati on
"l s
</ sw t ches>
<shar edLi st ener s>
<add nane="Fil eLog"
type="M crosoft. Vi sual Basi c. Loggi ng.
Fi | eLogTraceLi stener, M crosoft. Vi sual Basic, Version=8.
0.0.0, Culture=neutral,

Keysight MOOXA X-Series Measurement Applications for Modular Instruments 62




Publ i cKeyToken=b03f 5f 7f 11d50a3a,
processor Ar chi t ect ure=MsI L"
initializeData="FileLogWiter"/>
<I-- Uncomment the bel ow section and
repl ace APPLI CATI ON_ NAME wi th the nanme of your
application to wite to the Application Event Log -->
<! --<add nane="Event Log" type="System
Di agnosti cs. Event LogTracelLi stener™ initializeData="APPLI
CATI ON_NAME" [ > -->
</ shar edLi st ener s>
</ syst em di agnosti cs>
</ confi guration>

If you are modifying an existing solution you may need to add the startup setting to
the configuration section of the existing solution's app.config file.

Building the VB.Net Example

1. Open the VB_UsingM93917 project file.

2. Open the source code VB_UsingM93917.vb and review the code.

3. Build the VB_UsingM9397 project.
Compiling requires several .h include files that are installed by the MOOXA software,
M9391 driver, and VISA (from Agilent/Keysight 0 Libraries). These are found
through environment variables such as /VIROOTDIR32 and VXIPNPPATH which are

set by the installers. Linking requires these same environment variables to find
library files.

Running the VB.Net Example

You can either run the program from within Visual Studio, or find the .exe and
execute it.

You need to specify the following command line parameters:
= The ivi Alias name
-~ If you want to use/get simulated results add "sim" after the ivi Alias name.

You can also specify these parameters in Visual Studio. Click Project > Properties.
On the Debug tab, under the Start Options section, specify the command line
arguments.
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VB_UsingM9391
Application
Configuration: |Active(DEbug) v| Platform: |Active(x86) v|
Compile
Debug Start Action
@ Start ject
References T
Start external program:
Resources
] Start browser with URL:
Services
Start Opti
Settings T
B Command line arguments:  pyVSA sim .
Signing y
My Extensions
Securi —
Y Working directory: | |
Publish
B Use remote machine
Enable Debuggers
Enable unmanaged code debugging
Enable SQL Server debugging
/| Enable the Visual Studio hosting process

When you run the program, the following output appears:

?AAACore succeszsfully started.
Example usage ofszimulated M?391A IUVI driver session using resource *M?3I91A° .
Fharable IUI driver session successfully created.
Etarting the M?BHEA. please be patient.
?08A successfully started.
* Telnet Port = 5823
* Socket Uisa Address = TCPIPBA::5CB312080Q4::5825: -S0CKET
= Socket port = 50625
=* HiSLIP Uiza Address = TCPIP@A::5CBE312080Q4::hislipB: :INSTR
# HiSLIP Device Humber = 8
Loading WLAM application.

Press ‘i’ to use IUI driver. or 'x' to use MP7BXA.
ss the Escape (Esc) key to guit:

iDriver iz available for use.

Driver information:

AgHM?391
1.2_415.1
Agilent Technologies
M2321A
FirmuwareRev: Siml.2.415.1
Eimulate: True
IVI driver power measurement result: —35.26 dBm
river checked in. ready for use by others

ress ‘i’ to use IUI driver,. or 'x’ to use M?BEA.
ress the Escape (Ezc) key to guit:
M?B5A IDN responsze: Agilent Technologies .MH?8HA_ NAODOOABABA_M_14.58

PR L)

Fress 'i’ to use IUI driver. or 'x’ to use MIBXEA.
ress the Escape (Esc) key to guit:

Code Walkthrough

1. Open a session to the M9000 Resource Manager.

Keysight MOOXA X-Series Measurement Applications for Modular Instruments 64



OpenM9@@B@Session

Try
_myMB000Sessi on = Sessi onFactory.
OpenMB000Sessi on()
Catch e As Exception
Consol e. WiteLine("Could not start
MD000Session (details follow).")
Consol e. WiteLine(e. ToString())
Wi t For User ()
Cl eanup()
Return 1
End Try
Consol e. Wi telLine("M000Core successfully
started. ")

2. Create a sharable M9391 IVI driver session.

OpenSharableResource

Open the IVI driver as a sharabl e resource
Dimresult = _nmyMO000Sessi on.
OpensShar abl eResour ce( Resour cePl ugi nType, _iviAli as,
_resourceNane, sinul ate)
I f result <> ResourceManager Result. Gk Then
Consol e. Wi teLi ne("Coul d not open

sharabl e resource of type '" + ResourcePl ugi nType +
"' using alias """ + _iviAlias + "'. " + result.
ToString() + ". See Wndows Event Log.")
Wai t For User ()
Cl eanup()
Return 2
End |f

Consol e. Wi teLine("Sharable VI driver
sessi on successfully created.")

3. Start the M90XA Software.

M9@XA.Initialize

Try

Console. WitelLine("Starting the MOXA,
pl ease be patient.")

' Start the MDOXA

_nyMBOXA = New AgMBOXA()

Catch e As Exception

Consol e. Wi teLine("Coul d not
instantiate the MBOXA (details follow).")

Consol e. WiteLine(e. ToString())
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Wi t For User ()
Cl eanup()
Return 3

End Try

DimiviOptions As String = "Sinul at e=true"
DimoptionString As String = ivi Options
Try
_myMBOXA. I nitialize(_resourceNane, False
, Fal se, optionString)
Catch e As Exception
Consol e. WiteLine("Could not initialize
the MBOXA (details follow).")
Consol e. WiteLine(e. ToString())
Wi t For User ()
Cl eanup()
Return 3
End Try

4. Switch between the MOOXA Software and direct access to the M9391 driver
session by sharing the M9391 VI driver session.

The private method Usel vi Dri ver () shows how to check out the
hardware driver from Agilent M9000 Resource Manager, use it, then check-in
back so that it is available for use.

Checkout

" Check-out (lock) IVI HWdriver for my use
Di m nBO00OResour ce As MDOOOResour ce
I f _myMB000Sessi on. Checkout (_r esour ceNane,
nDO0O0Resour ce) <> Resour ceManager Resul t. Gk Then
Consol e. Wi telLine("Could not checkout
driver resource '{0}'", _resourceNane)
Wi t For User ()
Return 1
End I f
' Cast it to the type you asked for
Dimdriver = DirectCast (nm000Resource. |tem
| AgMB391)
Consol e. WiteLine("Driver is available for
use.")
" endr egi on

Use IVI

' Use IVI HWdriver resource
Note that if we are doing nultiple
checkout/checkin we may be able to skip
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sonme setup stuff if we know we were the
| ast user.

| f Not nPOOOResource. St at eQuesti onabl e Then

Consol e. WitelLine("No one used the

driver since we |ast unlocked it.")

End If

'Get sone driver properties, just as an
exanpl e

PrintDriverProperties(driver)

driver. Rest or eDef aul t Properties()

driver. Acqui siti onMbde =
AgMB391Acqui si ti onModeEnum
AgMB391Acqui si ti onMbdePower

driver. Power Acqui si ti on. Configure
(10000000. 0, 0.001) ' M1z Bandwi dth, secound duration

driver. Appl y()

driver. Arm()

D m power As Double = -200.0

Di m overl oad As Bool ean = Fal se

dri ver. Power Acqui si ti on. ReadPower ( O,
AgMB391Power Uni t sEnum AgMB391Power Uni t sdBm power,
over | oad)

Consol e. WiteLine("IVI driver power
nmeasurenment result: {0: G4} dBm', power)

Checkin

' Check-in (unlock) IVI HNVdriver so others may use
it
_myMB000Sessi on. Checki n( M@000Resour ce)
Consol e. WiteLine("Driver checked in, ready
for use by others")

Internally, the MOOXA is also checking out the same resource, using it, and
checking it back in.
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89600 VSA: Running In-Process and Sharing Hardware Driver
Sessions

NOTE Traditional Ul supports 89600 VSA running in-process with MO0XA 24.0. To
start the M90XA and 89600 applications from the Start menu, select All

Programs > Keysight > MOOXA X-Series Applications 24.0 > Keysight MOOXA
24.0 + 89600 VSA (64-bit).

While the multi-touch Ul does not support 89600 VSA running in-process with
M90XA.

In some applications it is desirable to use the 89600 VSA Software in-process with
the MOOXA X Series Applications and/or user programming. The primary advantage
is that the hardware driver session may be shared between apps very quickly,
nearly eliminating mode switching time.

User Env. (.EXE or LV)

I I I
NET@rc  SCPI  NET or SCPI

MS0XA 89600
Apps VSA
(in-proc.) | (in-proc.)

Resource Mar.
VI-Diriver

Minimum Version Requirements

- MOOXA X-Series Applications: 24.0

= 89600 VSA Software:
- For M9391A and M9393A Classic Mode (9KHz to 27GHz): 19.02
- For M9393A Extended Frequency Mode (3.6GHz to 50GHz): 21.0

NOTE If multiple versions of 89600 VSA Software are installed, the newest version
should be used.

Preparing the 89600

Before attempting to run the 89600 in-process with the MO0OXA, you must prepare
the SCPI Connection Type and the Hardware Configuration as described below.
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SCPI Preferences

When the 89600 is running in-process with the M9OXA and an SCPI connection is
being used to communicate with the 89600, conflicts can arise.
To avoid potential conflicts:

- The 89600 must not be configured to use a HiSLIP connection type.

- If Telnet or Socket connection types are used, the port numbers must not
conflict with port numbers on the MOOXA.

- The M90XA must be started before the 89600 VSA Software.
If the 89600 .NET APl is being used then the 89600 connection type should be set
to None.
1. To set the connection type,
2. Start 89600 VSA Software normally
3. Select Utilities » SCPI Preferences.
4

. Set the Connection Type.
The setting persists when you close the 89600 VSA Software.

’T:_ User Preferences @

Startup Preferences | Extension Manager | General Preferences | SCPI Preferences

~Internal SCPI Server

~Connection Type ——— ~Logging
Nene Level: | Error v|
) Telnet
Port: 9024 Maximum Entries: 1000
| Socket ~Status
Port: 9025 LTt
| HiSLIP Socket, Port=9025
Device: Example Address: TCPIPO:TCE-LARRYE:8025:50CKET

[ Restart Server

External SCPI Server

“y Configure..

il

Hardware Configuration

The M9391 and M9393 Soft Front Panels save hardware and driver configuration
information to the IVI Config Store as named connections. When the M90XA is
initialized, this name is used to specify the hardware to use. (For more information,
refer to Launching M90OXA Software.) This name is also used by the M9000
Resource Manager for sharing the driver instance. (For more information, refer to C
(Sharp) Example.)
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The 89600 VSA Software saves hardware and driver configuration information
differently, so it is necessary to create the configuration both ways and then map
the IVI logical name to the 89600 configuration name. By convention, these two
names must be identical.

When you want to use M9000 Resource Manager for sharing hardware driver
session between 89600 VSA and M90XA X-Series Applications and/or user
programming, you must pass a command-line argument to 89600 to indicate
that Resource Manager sharing should be used along with the configuration to
use it with, and the IVI logical name that should be used with it. Following is
the syntax for this command-line argument:

/ MB000: <89600 Confi guration Name>=<|IVI Logi cal Nane
fromlVl Config Store>

Sharing the M3300A Frequency Reference Module

The Keysight M9300A PXle Frequency Reference module can be shared across
multiple measurement applications. While the M9300A module is being shared, any
of the configurations that share this reference can control it fully. However, the user
interface of some applications may not reflect M9300A settings made by other
applications. For example, the Keysight 89600 software might change it to an
internal reference, but the MOOXA soft keys might not show that.

To work around this situation, perform either of the following steps:

- Configure the M3300A Reference module the same way in both the
applications.

- Leave the M9300A Reference module out of the configuration and use the
M9300A Soft Front Panel (SFP) to configure it before starting the apps.

Starting the 89600

To start the MO0OXA and 89600 applications from the Start menu, select All
Programs > Keysight > MOOXA X-Series Applications 24.0 > Keysight MOOXA 24.0 +
89600 VSA.

To start the MI0OXA and 89600 applications in-process with your own program, see
the programming example C (Sharp) Example Form with 89600. There is a shortcut
to the example programs on the Start menu at All Programs > Keysight > M9OXA X-
Series Applications 24.0 > Examples.
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Sharing the Hardware

Checkout

To “check out” the shared driver session for use by the 89600 VSA Software, simply
set a hardware parameter or start the measurement. The 89600 does the checkout
automatically any time the user performs an action that requires hardware access.
If the shared driver session is not available because it is checked out to another
application, the request times out.

The MO0OXA X-Series Applications wait patiently for the driver session to
become available and allows the user to abort the request at any time.

Check in

To “check in” the shared driver session so that it can be used by other applications,
select Control > Disconnect from the 89600 VSA Software GUI (or Measurements.
Selectedltem.SelectedAnalyzer.Disconnect(); from the API).

The M90XA X-Series Applications automatically checks in the driver session
after every hardware access. With the 89600, you must explicitly disconnect
from the hardware before the driver session is checked in.

Programming Example with 89600 VSA
This section covers the available programming examples for M90OXA and 89600
VSA.

For more information about programming with M9OXA, refer to Programming with
MOO0OXA.

- C (Sharp) Example Form with 89600

C (Sharp) Example Form with 89600

This section covers the CS_ExampleFormWith89600 example program provided
with the MOOXA Software. This example program demonstrates the use of 89600
VSA software in-process with the MIOXA X-Series Applications and user
programming. For more information, refer to 89600 VSA: Running In-Process and
Sharing Hardware Driver Sessions.

A single example program caters to both M9391A and M9393A. Create a copy of
the Examples folder and double-click the CS_ExampleFormWith89600 project file
to open it in Visual Studio.

References

This example references the assemblies as displayed below:
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Solution Explorer

= | 2 (2]

"f|l><

; Solution 'C5_ExampleFormWith89600' (1 project)
' CS_ExampleFormWith89600

> [=dl Properties
a | _ References

A3 Agilent. AgMI0KAInterop
A3 Agilent.AghI391.Interop
A3 Agilent.AgM2393.Interop

-3 Agilent.hB000

43 Agilent.5AVsaInProcessFactorny
A3 Agilent.5A.VsaInterfaces
-3 Ivi.ConfigServerInterop

-3 Ivi.DriverInterop

43 IviVisaInterop
1 Systermn

A Systern.ComponentModel.Composition

A3 Systern.Core

43 Systermn.Drawing

23 Systermn Windows. Forms

. [Z] ActiveAppForm.cs
=5 app.config
. [E] MainFaorm.cs
] Program.cs
Assembly Purpose Copy Local
Agilent. AgM90XA.Interop The Agilent M9OXA IVI-COM driver False
Agilent. AgM9391.Interop The Agilent M9391 IVI-COM driver False
Agilent.AgM9393.Interop The Agilent M9393 IVI-COM driver False
Agilent.M9000 The Agilent M900O0 Application Framework False
Agilent.SA.Vsa. For starting the most recent installed version of Agilent 89600  False
InProcessFactory
Agilent.SA.Vsa.Interfaces The Agilent 89600 interface definitions False
Ivi.ConfigServer.Interop For reading the VI Configuration Store False
Ivi.Driver.Interop For VI driver communications False
Ivi.Visa.Interop For SCPI communications False
Keysight MOOXA X-Series Measurement Applications for Modular Instruments 72



73

By default, after MOOXA installation, CS_ExampleFormWith89600 project has
two references:

- Agilent.SA.Vsa.InProcessFactory.dll located in M90XA installation
directory (C:\Program Files\Agilent\M90XA\24.0\Agilent.SA.Vsa.
InProcessFactory.dll)

- Agilent.SA.Vsa.Interfaces.dl! located in
CS_ExampleFormWith89600 folder

You can also change the reference of Agilent.SA.Vsa.Interfaces.dll to the
Agilent 89600 installation directory on your machine. This is done by setting
Copy Local to False (C:\Program Files\Agilent\89600 Software 20.0\89600 VSA
Software\Interfaces\Agilent.SA.Vsa.Interfaces.dll). But you cannot add it to the
M90XA installation directory (C:\Program Files\Agilent\M90XA\24.
0\xSA\Common\Agilent.SA.Vsa.Interfaces.dll).

App.Config

The Agilent M9000 Resource Manager uses version 4.0 of the .NET Common
Language Runtime. The app.config file (as displayed below) has a startup
configuration to allow interoperability with older components that were developed
for Version 2 of the CLR.

ET GGl ActiveAppForm.cs [Design] Program.cs MainForm.cs MainForm.cs [Design]
<?wml version="1.8"2>
—l<configuration>
—l<startup uselegacyV2RuntimeActivationPolicy="true">
<supportedRuntime version="v4.8" sku=".NETFramework,Version=v4.@8"/>
<fstartup>
<fconfiguration>

If you are starting from scratch and an app.config file does not exist in your
solution:

1. Right-click on the startup project name and select Add New.
2. From the list of Visual C# items, select Application Configuration File.

3. Copy the following text into the App.config file:

<?xm version="1.0"?>
<confi guration>
<startup useLegacyV2Runti neActivationPolicy="true">

<supportedRuntime version="v4.0" sku=".NETFraneworKk,
Ver si on=v4.0" />

</startup>

</ configuration>
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If you are modifying an existing solution, you may need to add the startup setting to
the configuration section of the existing solution's app.config file.

Running the Program

In addition to source code, a compiled exe is installed. To run it, click Start > All
Programs > Keysight > M9OXA X-Series Applications 24.0 > Examples >
CS_ExampleFormWith89600 (64-bit).

The following is a screen capture of the main form.

5! CS_ExampleFormWith89600 = e~

Sharable V] Driver

Name [ - ]

Alias [ v] Alias help ... Open SFP...

Simulation Mode

[ Open Session l Session Status

Keysight M3000 Client Applications
Keysight M30XA ¥-Seres Applications

| StatMIOXA | MI0XAStatus
Keysight 89600 VSA
| statg9s00 | 89600 Status

Hardware Sharing Example: Band Power

Center Frequency (Hz)  2e3 Range (dBm) 0
Bandwidth (Hz) 1e6
Using%App | | UsngViDiver ||  Using 88600 |

Here are the steps to run this example program:

1. Open the M9391 or M9393 driver session based on an VI driver Name, and a
saved hardware configuration Alias. Click Open Session to open the driver
session.

2. After the shareable IVI resource session is open, you may start the M90OXA
software by clicking the eStart M90XA button.

3. Similarly, you may start the 89600 VSA by clicking the Start 89600 button.
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4. Next, specify the values for the parameters for band power measurements.

5. Make measurement using MOOXA X-Apps, IVI Driver, or 89600.
To “check out” the shared driver session for use by the 89600 VSA Software, simply
set a hardware parameter or start the measurement. The 89600 does the checkout
automatically any time the user performs an action that requires hardware access.

If the shared driver session is not available because it is checked out to another
application, the request times out.

Note that the MYOXA X-Series Applications wait patiently for the driver session to
become available and allows the user to abort the request at any time.

To “check in” the shared driver session so that it can be used by other applications,
select Control » Disconnect from the GUI (or Measurements.Selectedltem.
SelectedAnalyzer.Disconnect(); from the API).

Note that the MYOXA X-Series Applications automatically check in the driver
session after every hardware access. With the 89600, you must explicitly
disconnect from the hardware before the driver session is checked in.

Code Walkthrough

To review or modify this program, make a copy of the Examples folder, then open
the CS_ExampleFormWith89600 project file in Visual Studio.

Use Visual Studio to View Code in MainForm.cs in the CS_ExampleFormWith89600
project. Near the beginning of this file are some #define directives for each
supported VI driver. Unless you have all the VI drivers installed, you need to delete
or comment-out directives for IVI drivers that you are not using.

#define M9391 SUPPORTED // remowve this line to compile without the M9391 IVI driver.
#define M9393_SUPPORTED // remove this line to compile without the M9393 IVI driver.

This example is similar to the other C# examples in the following areas.

1. Open a session to the M9000 Resource Manager.

2. Create a sharable M9391 IVI driver session.

3. Start the M90OXA Software.

4. Switch between the MOOXA Software and direct access to the M9391 driver
session by sharing the M9391 VI driver session.

This example adds the Keysight 89600 VSA Software to the process.

1. Start the 89600 VSA Software.

2. Switch between the 89600, M90OXA, and direct access to the M9391 driver
session by sharing the M9391 VI driver session.
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Starting the 89600 VSA Software

This example is designed so that it does not directly reference the Keysight 89600
VSA Software installed on your computer. This allows you to install a newer version
of 89600 at a later date, without having to update a reference and re-compile this
program. There are two parts to the 89600 startup, first to create to VSA instance
as an object, and second to cast it to an Agilent.SA.Vsa.Application.

Starting the 89600 VSA Software

try

{

/1l This programreferences (with Copy Local = fal se)
a fixed version of

/1l Agilent.SA Vsa.lnterfaces.dl|l which is
distributed with the exanpl e.

/]l To start the 89600 VSA Software we are calling
the | nProcessFactory. This all ows

/1l us to get the latest installed version of the
89600 wit hout referencing the

/1 particular version of Agilent.SA Vsa.lnterfaces.
dil directly.

/1 This has the advantage that an upgrade to the
89600 VSA Sof t war e

/1 will not break this program

/[l Start the latest installed version of the 89600
VSA Sof t war e

var success = Set up89600( | nProcessFactory. Creat e(nul |
,-1, 0, commandLi neArgs));

i f(success)

{
[/ MBOXA is running; update GU state
| bl 89600St at us. Text = "89600 VSA Runni ng";
_currentState = _currentState | State.VsaStart ed;
Updat eCui () ;
}
el se
| bl 89600St at us. Text = "89600 VSA Did Not Start";
}
cat ch (Exception ex)
{
| bl 89600St at us. Text = ex. Message;
}

Casting to Agilent.SA.Vsa.Application

private bool Setup89600(object appCbject)
{
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/[l This is in a private nethod so that the JIT
conpi | er does not | ook

/1l for VsaApplication before the |nProcessFactory
has | oaded the interfaces assenbly

_my89600 = appCbj ect as VsaApplication;
if (_ny89600 != null)
{
_my89600. | skxi t Enabl ed = fal se;
_my89600.Title += " - Running In-Process with
Agi | ent MBOXA";

/1 Disconnect the 89600 so it will check in the
har dwar e dri ver.
_my89600. Measur enent s. Sel ect edl t em
Sel ect edAnal yzer. Di sconnect () ;
return true;
}

return fal se;

Switching between 89600, MOOXA, and the IVI driver session

Because the MOOXA and 89600 VSA applications may be used interactively from
the graphical user interface, it is possible that one of these applications has the VI
driver session checked out at the time that the Using IVI Driver button is pressed. In
the click event handler, force the applications to check in the IVI driver session with
the following code:

Force Applications to Checkin Driver Session

/1 Stop any runni ng MBOXA neasurenents so it will check
in the hardware driver.
if (_myMBOXA !'= null)

_myMBOXA. St op() ;

/1 Disconnect the 89600 (if necessary) so it will check
in the hardware driver.
if (_current State. HasFl ag(State. Vsa))

Di sconnect 89600() ;

Likewise, the Using X-App event handler disconnects the 89600 and the Using
89600 event handler stops the MIOXA.
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Troubleshooting
This section covers the procedures to troubleshoot some common problems with
MOOXA.
- Common Problems

- Technical Support

Common Problems

Here are some common problems you may encounter:
- LTE-Advanced Apps are only available as 64-bit Applications
- Difficulty starting M90XA
= Incorrect Alignment Results in M9393

Difficulty starting M9OXA

If you have difficulty starting the MO0OXA, you need to first verify that you can
connect to the M9391 or M9393 VSA via its Soft Front Panel and that you have a
working hardware configuration saved into the VI store.

To start the M9391 Soft Front Panel, go to Start > All Programs > Keysight > M9397
> M9391 SFP.

To start the M9393 Soft Front Panel, go to Start > All Programs > Keysight > M9393
> M9393 SFP.

For more information about the M9391 SFP, refer to M9391 Help available at: Start
> All Programs > Keysight > M9391 > M9391 Help.
For more information about the M9393 SFP, refer to M9393 Help available at: Start
> All Programs > Keysight > M9393 > M9393 Help.

Incorrect Alignment Results in M9393

When using M9393, by default, the measurements are made according to the
factory calibration data. If necessary, you can perform additional alignments to
improve Amplitude accuracy and LO nulling. Before you perform alignments using
M9393, ensure that you disable any RF signal being input to M9393. Any incoming
RF signal can alter the alignment results. Hence, when you perform alignments
using Utilities > Alignments, the following message box is displayed.

Keysight M9393 VSA Alignments X

Disconnect the RF input signal.

Click Ok to run the alignment.

[ OK ] [ Cancel ]
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You must disconnect the RF input signal and then click OK to perform alignments.
For more information on Alignments, refer to Keysight M9393 Soft Front Panel Help.

Technical Support

In case of any problems related to the working of MOOXA Software, contact the
technical support at www.keysight.com/find/contactus.
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